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Micro Focus Visual COBOL 9.0 for Eclipse
Distributed Edition Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus Customer Support Documentation
Web site for any documentation updates.

Product overview

The Micro Focus Visual COBOL for Eclipse Distributed Edition package comprises the following products
which you can download from your Electronic Product Delivery Note:

• Visual COBOL for Eclipse - the product provides an Eclipse-based integrated COBOL development
environment for Windows or Linux. Visual COBOL for Eclipse provides COBOL JVM support and
enhanced compatibility with ACUCOBOL and can be used standalone for developing local applications
or in conjunction with the Visual COBOL Development Hub to develop remote projects in Linux and
UNIX.

• Visual COBOL Development Hub - the product provides a rich desktop development environment based
on the Eclipse IDE with high-performance server-based tools for managing builds, source code access
and the debugger engine. Visual COBOL Development Hub also provides a central administration site,
simplifying the development tool distribution and maintenance process.

Upgrading from earlier Micro Focus products

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.
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What's New
Enhancements are available in the following areas:

• Learn Micro Focus™ Learn COBOL extension and Micro Focus™ COBOL Fundamentals Course
• Micro Focus COBOL Extension for Visual Studio Code
• .NET Support
• Application Workflow Manager
• COBOL Language
• Compiler Directives
• Data Modernization Advice
• Database Connectors for Visual COBOL
• Debugging
• Eclipse Integration
• Enterprise Server
• Enterprise Server Common Web Administration (ESCWA)
• Enterprise Server Security
• Interface Mapping Toolkit

Learn Micro Focus™ COBOL Extension for Visual Studio
Code and Micro Focus™ COBOL Fundamentals Course

Back to Top

Micro Focus has released a new video-based training course in COBOL, Micro Focus™ COBOL
Fundamentals Course. The course teaches the fundamentals of the COBOL language, introduces the
Micro Focus™ COBOL syntax, and usage of Micro Focus COBOL tools.

The course is ideal for developers familiar with C, Java, or .NET who want to learn COBOL. It doesn't
matter what language you know, as long as you have experience of standard programming concepts, this
course is for you.

A new Learn Micro Focus™ COBOL Extension for Visual Studio Code is available. The extension comes
with the training materials for the COBOL training course. For information about the COBOL course, and
the Learn Micro Focus™ COBOL Extension for Visual Studio Code, visit www.cobol.com.

Note: This extension is not included with the Visual COBOL installer.

Micro Focus™ COBOL Extension for Visual Studio Code
Back to Top

The following features are now available in the Micro Focus™ COBOL Extension for Visual Studio Code
when you use it with Visual COBOL 9.0:

• JVM COBOL debugging
• COBOL notebooks where you can have text and executable blocks of COBOL code in the same file.
• Colorization for COBOL directives files, cobol.dir.
• A new button, , Debug COBOL Program or Run COBOL Program in the top right corner of the

editor, present for the current COBOL program.
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• Configuration setting for custom tab stops.
• A Micro Focus COBOL terminal in the TERMINAL pane.
• You can now specify the COBOL main file context for copybooks if a copybooks is referenced in more

than one program.

Note: This extension is not included with the Visual COBOL installer.

.NET Support
Back to Top

This release provides the following enhancements to .NET support:

• This release installs several NuGet packages each of which contains the assemblies for a specific Micro
Focus functionality. New .NET projects, as well as existing projects you edit or build in 9.0 are linked to a
core package, MicroFocus.COBOL.Runtime.Core, that includes the basic functionality for the projects.
You need to add any additional packages (such as a specific file handler, COBOL Accept/Display etc.)
manually to the projects. The new packages enable better granularity of distributions, and provide more
flexibility and control over what is packaged with the application.

• New SDK version - the Micro Focus SDK version has changed to version 2.1. See Upgrading
existing .NET COBOL project files in your product Help for details on how to upgrade your existing
projects.

Application Workflow Manager
Back to Top

This release offers the following improvements:

• A new Git Function Package - provides tools that support common Git interactions such as Clone, Add,
and Commit. This function package provides tool types to integrate the distributed revision control
system Git into your AWM model and enabling you to build a development workflow that includes Git
version control actions within the AWM Team Developer perspective.

• The Micro Focus z/Server connection is now supported in Visual COBOL (UNIX) in the Remote
Systems view. A Micro Focus z/Server connection provides access to an IBM z/OS system enabling you
to work on data sets of the MVS subsystem, manage job output from the JES subsystem, and work on
files of the USS file system.

COBOL Language
Back to Top

This release provides the following new features and enhancements to the COBOL language:

• Double-colon, ::, qualification is now available as a qualifier for data names and when dereferencing
pointers.

• PERFORM frame local variables - variables that are DECLAREd are now properly scoped. Reentering
the SECTION, whether recursively or after leaving, gives a new instance of such variables. This
provides better locality of data, and helps with writing of better structured code.

• Parameterized sections - syntax that allows program sections to accept arguments and return values.

• PERFORM of a SECTION can now pass arguments to that SECTION.
• A result can be returned to the code that PERFORMed the SECTION.
• Sections that return a value can be used as functions, in contexts where an identifier is expected.
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• Compiler can identify platform at compile time - the compile-time constants __unix, __windows,
__dotnet, __jvm, and __native have been introduced. These can be tested in $if statements to
tailor code to the platform being used.

• Enhanced CBL_STRING_CONVERT library routine - CBL_STRING_CONVERT can now convert
strings to and from Base64.

The following enhancements add further support for the IBM Enterprise COBOL version 6.4:

• User-defined functions - user-defined functions are now available in an Enterprise COBOL dialect for
version 6.4 compatibility. Reference the product Help, General Reference > COBOL Language
Reference > Part 3. Additional Topics > Additional Dialect Support > Enterprise COBOL Syntax Support
> User-Defined Functions under ENTCOBOL dialect. A new Compiler directive, MANAGED-FNC-
PARAM-BY, enables you to specify whether the managed behavior of numeric function parameters
should default to BY VALUE or BY REFERENCE.

• Enhanced mechanism for interoperation between Java and COBOL - The COBOL and Java
interoperability has been enhanced to extend the capabilities of your COBOL applications with Java. It
removes the need to write object-oriented (OO) COBOL, as your native COBOL and Java programs can
now interoperate in the following scenarios:

• COBOL programs can be marked as JAVA-CALLABLE, meaning that they can be called from Java
as though they were Java static methods.

• COBOL program can call Java static methods using the java.class.method call.
• COBOL data can be shared with Java programs by marking it as JAVA-SHAREABLE.

• Comprehensive support for automatic conversion between a wide variety of popular Java data types
and their corresponding COBOL types so that parameter passing and returned value handling require
no special processing in user code.

Compiler Directives
Back to Top

This release provides the following enhancements.

A new mechanism for setting Compiler directives (Technology Preview):

• Common directives files - this release introduces common directives files, directives.mf files, that
enable you to automatically provide all required directives needed to compile multiple COBOL
applications without having to specify the directives individually. This feature is not available for
Assembler or IMS.

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use
and it is not supported as such. Furthermore, Micro Focus does not guarantee that this feature will
be delivered at a GA level and if it is, then the functionality provided might differ considerably from
this technology preview.

New Compiler directives:

• ALPHA-LIT-CONT - determines whether the right margin or the end-of-line is used to delimit the
continuation of a non-numeric literal.

• DECLARE - defines the behavior of locally declared variables.
• ILEXPOSEALPHA/ILEXPOSEGROUP - these two directives can expose alphanumeric or group items

passed by value to parameterized sections or methods in JVM COBOL programs as byte arrays (the
default is to expose as string objects).

• ILSTRINGLOAD - where JVM COBOL programs with a very large number of distinct alphanumeric
literals cause internal limits to be exceeded, use this directive to create these literals in a backing file,
which can then be converted to strings at run time.
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• MANAGED-FNC-PARAM-BY - determines whether user-defined function parameters are passed BY
VALUE or BY REFERENCE by default when compiled with JVMGEN.

• INITIAL - determines how Working-Storage is initialized for programs marked as IS INITIAL.

A family of new Compiler directives has been introduced to support the new mechanism for interoperation
between Java and native COBOL:

• JAVA-SHAREABLE - use the JAVA-SHAREABLE ON and JAVA-SHAREABLE OFF directives to bracket
one or more WORKING-STORAGE data items to indicate that they are to be made read and write
accessible from Java applications interoperating with this COBOL program.

• JAVA-CALLABLE - instructs the Compiler to make the COBOL program automatically callable from
Java.

• JAVA-GEN-PROGS, JAVA-GEN-STRG, JAVA-OUTPUT-PATH, and JAVA-PACKAGE-NAME - control the
behavior of COBOL programs that interoperate with Java through the JAVA-CALLABLE or JAVA-
SHAREABLE directives or by calling Java static methods using the CALL statement.

Data Modernization Advice
Back to Top

The product Help now includes advice on moving your COBOL data files, such as flat files, VSAM, indexed
or sequential files, etc. to a relational database (RDBMS). The documentation lists the solutions included in
Visual COBOL that enable you to achieve this, including advice on the best option for your application as
well as performance considerations.

Database Connectors for Visual COBOL
Back to Top

This release provides the following enhancements:

• Better control of permissions granted on newly created tables.

When creating a table, the SQL Server interface also creates an index, and grants loose permissions to
everyone via the A-MSSQL-GRANT-PERMISSIONS and A-MSSQL-GRANT-USERNAME configuration
variables with their default values. If database permissions are not set to allow these loose permissions,
the GRANT statement fails, causing OPEN OUTPUT to fail.

See A-MSSQL-GRANT-PERMISSIONS and A-MSSQL-GRANT-USERNAME for details.
• Increased table and column name sizes for ODBC

To accommodate the number of characters the ODBC driver allows, this release increases the allowable
table name and column name sizes for ODBC via two new ODBC configuration file variables. For
details, see A_ODBC_MAX_COLUMNNAME_LEN and A_ODBC_MAX_TABLENAME_LEN.

• Support for all currently available versions of the MIcrosoft SQL Server ODBC Driver, which have been
tested through version 18.

See the following Configuration Variables topics for details:

A_MSSQL_ODBC_DRIVER_NAME
A_MSSQL_ENCRYPT_CONNECTION
A_MSSQL_TRUST_SERVER_CERTIFICATE
A_MSSQL_EXTRA_CONNECTION_INFO

• The A_MSSQL_IDENTITY_TYPE configuration variable has been added to enable you to configure the
identity column to be a larger type, and to store a 64-bit value internally. Set
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A_MSSQL_IDENTITY_TYPE to a string value that represents a fully qualified data type for your
database. The default is:

 A_MSSQL_IDENTITY_TYPE="numeric(9,0)"

Debugging
Back to Top

This release provides the following new feature:

• In Eclipse, new Debug and Run configurations have been added for debugging and running COBOL/
Java Interoperability applications. These enable you to debug COBOL programs calling Java static
methods. To debug Java code calling a COBOL program, you must create a Java Application launch
configuration and manually define the VM arguments property -Djava.library.path with a value
representing the output path to the native library produced from the COBOL builder.

Eclipse
Back to Top

Enhancements are available in the following areas:

Eclipse IDE:

• Eclipse 4.24 (2022-06) support, which is shipped and installed with Visual COBOL. Versions of Eclipse
prior to this one are not supported.

• Exporting code coverage results - an option has been added to the Code Coverage view to allow you
to export the current code coverage results to a .tcz file.

• The Problems view now displays a sequence number column.
• A new project template is available for COBOL/Java interoperability applications. The project enables

you to compile both COBOL and Java sources at the same time.

COBOL editor:

• Auto-indenting on end-*.
• Collapsible regions for EVALUATE statements, and for 01 group items - a new option, Enable folding

for group level items, has been added to the Eclipse preferences (Window > Preferences > Micro
Focus > COBOL > Editor > Folding).

• Local variables support.
• Parameterized sections - support is available in the editor for parameterized sections.
• Paste JSON as COBOL classes - you can now copy JSON data and do a Paste JSON As Classes into

a JVM COBOL file. This generates COBOL classes which enable you to deserialize the data in those
classes.

• A Quick Fix is available for end of scope termination. To enable this, your project must have the
NOIMPLICITSCOPE Compiler directive set, and error level to warning as errors.

• Renumber lines on save - line numbers can be automatically applied to a source file when it is saved,
by selecting Perform line numbering on save from Window > Preferences > Micro Focus > COBOL
> Editor > Line Numbering.

• Case preference for COBOL keywords on code clean up. A new preference in the code clean up profiles
enables you to convert all COBOL keywords to uppercase or lowercase, if required.

Enterprise Server
Back to Top
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This release provides the following enhancements:

• A new casverify command-line utility is available. This utility enables you to verify the configuration of
a specified enterprise server region without attempting to start it, and also enables you to create
immediate diagnostics information in JSON or human-readable output. Verification stages are modular,
enabling you to specify which validation checks to run.

• You can now list job steps to enable users to perform advanced restarts. Job steps can be output to
JSON by specifying casout /%jnumber or output to a table by specifying casout /%tnumber. See
casout for more information.

• Installation improvements on UNIX - when upgrading from releases 6.0, 7.0, or 8.0 on UNIX, Visual
COBOL now preserves more configuration details. During the installation of the product, a set of
configuration files are moved to a config location before the upgrade occurs. These are linked back to
the product install location on completion. When you reinstall the full product, install a patch update, or
install an upgrade to the same location, the previous configurations settings are maintained.

Previously, the upgrade process required manual intervention to redeploy existing configuration settings.
This now occurs automatically.

Enterprise Server Common Web Administration (ESCWA)
Back to Top

Enhancements are available in the following areas:

• Accessibility improvements - provide improved compliance with 508 and WCAG 2.1 standards.
• API, version 2 extensions - includes updated versions of some of the existing API version 1 endpoints,

and has been extended to contain more endpoints.
• Merged Archived Spool - you can now configure an enterprise server region to view a merged archived

spool in the UI. You can view multiple archived spools from a single region, and view old spool
information for multiple jobs that have ran under a previous name

• Page search facility - you can now search for a page that contains a specified search string. This
enhancement is part of the WCAG 2.1 requirements for accessibility.

• PAC clients - the ESCWA UI lists all TN3270 clients connected to a PAC. This enables you to administer
and monitor clients across the entire PAC from a single PAC region.

• TLS-enabled Redis connections. ESCWA now supports administering and monitoring PACs with a TLS
Redis SOR.

Enterprise Server Security
Back to Top

This release provides the following new features and enhancements:

• Demo CA - the component has been completely redesigned and is now included as part of Visual
COBOL. Demo CA supports multiple installations, uses up-to-date cryptographic support, and
generates modern version 3 certificates with SANS, PKIDs, AKIDs, etc. signed by an intermediate CA.
Demo CA is now easier to use and has improved interoperability with third-party SSL/TLS systems.

Note: Micro Focus strongly recommends that Demo CA is only used for SSL/TLS development
and testing and is not intended for use in a production environment.

• esfupdate support for the Vault Facility - the esfupdate utility now supports the use of the Vault
Facility for credentials it needs to connect to MFDS.

• OpenSSL 3.0 - OpenSSL has been updated to use the current Long Term Supported OpenSSL
cryptographic library.

• VSAM External Security Manager (EAP) - the VSAM ESM Module is a new option for Enterprise Server
security which is simpler and more convenient than using LDAP-based security. The VSAM ESM
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Module provides a security manager for Enterprise Server which keeps security data in COBOL data
(VSAM) files. It provides many of the features of the MLDAP ESM Module but does not require an LDAP
server or other third-party solution. Security data can be imported from a YAML file, facilitating the
securing of Enterprise Server and the modification of its security data.

Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus Customer Care if you require
further clarification.

HCO for SQL Server
Back to Top

This release includes support for the following:

• The Define Lists tool in the HCOSS UI has been enhanced to enable you to select a dependency mode
to use when creating a transfer list. The available modes are:

Default Automatically include all parent objects of the selected object.

Family tree Automatically include all parent objects of the selected table.

Automatically include the child objects of each parent object.

Repeat until no more parents and children are found.

No dependency handling Include the selected table only (do not include any parent or child objects).

• The Transfer Data Tool now includes the start and end date and time for each table transfer.

Interface Mapping Toolkit
Back to Top

This release provides the following enhancements:

• YAML support is now available for COBOL client generation. OpenAPI schemas can now be in YAML, in
addition to JSON format.

• A new option, Refresh Service, has been added to the Web Services and Java Interfaces context
menus. Use the Refresh Service option to update the bitism of the program for an existing Web
Service or Java interface after changing the bitism of the Eclipse project or the COBOL program.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• .NET Support
• Application Workflow Manager
• Compiler
• Data Tools
• Eclipse IDE
• Enterprise Server
• File Handling
• Micro Focus Directory Server
• Runtime System
• Setup Issues (Windows)

.NET Support

Back to the list

• The 9.0 release installs several .NET 6 NuGet packages each of which contains the assemblies for a
specific Micro Focus functionality. New .NET projects, as well as existing projects you edit or build in 9.0
are linked to a core package, MicroFocus.COBOL.Runtime.Core, that includes the basic
functionality for the projects. You need to add any additional packages (such as a specific file handler,
COBOL Accept/Display etc.) manually to the projects.

Building existing .NET COBOL projects created prior to 9.0 might result in build errors. You can ensure
compatibility by enabling the use of the MicroFocus.COBOL.Runtime metapackage. Alternatively,
you need to add any required NuGet packages manually to the older projects.

See Upgrading existing .NET COBOL project files in the product Help for details on how to upgrade.

Application Workflow Manager

Back to the list

• The related AWM resource (required to perform the resource operation) of the open file is now cached.

02307586 (278005)

Compiler

Back to the list

• Preprocessor options of more than 256 bytes are now supported, and no longer cause the Compiler to
crash.

02289875 02308713 (272069)

Data Tools

Back to the list

• A new print function available from the File group and the File menu enables you to print the records
shown in the editor.
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00367084 (12432)
• An enhancement to the Compare Files function has been added, so that when a comparison is made,

the File Information option shows a statistics overview of the comparison being displayed.

02200177 (222157)
• In the Data File Editor, the Compare Files function has been enhanced to allow you to select start and

end columns in which to compare, so only a subset of a record is compared, rather than the entire
record.

02306654 (222159)
• A Quick final page access option has been added to the Preferences dialog box of the Data File

Editor. When selected, large variable sequential files (files > 10,000 records) immediately jump to the
last page of the file when it is opened.

02330923 02365033 02399254 (294002)

Eclipse IDE

Back to the list

• When creating a new remote project using the SSH file system, the wizard now allows you to create a
new Micro Focus DevHub using SSH connection. (Previously, only the Micro Focus DevHub SSH
Only connection was available.)

(301058)
• The Import Server option (from within Server Explorer) is now working correctly with an XML if the

XML file type is known. If the XML file is in an unknown format, an error message is displayed, and
import is not possible.

02345573 (310017)

Enterprise Server

Back to the list

• A new option to uninstall a PAC installed on an enterprise server region before deleting the region has
been added to ensure that all PAC components are properly removed.

01907370 (124107)
• ESCWA now validates the TLS properties to help prevent errors on entry.

Note: If ESCWA has an invalid TLS configuration, it reverts to starting without TLS enabled.

01983736 (203178)
• In ESCWA, a Stop for IMS MPRs, JES Initiators, and JES Printers now operates correctly.

02311796 (286178)
• An issue with not being able to update or navigate the ESCWA UO though the job output in the spool

while it is still running has been resolved.

02322494 (286142)
• In ESCWA, the default dashboard can now be modified for all users of a server.

02458710 (392040)
• In ESCWA, the FCT Fix Up button has been added to the Active FCT page. See Active FCT in your

product Help for more information.

(374021)
• The Job View page in ESCWA now includes a list of job steps that have run during the current

enterprise server region up time.

(347033)
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• A new configuration property has been added to ESCWA to enable the default language the UI displays
to be overridden from the user's browser locale.

02227239 02307446 (260128)
• ESCWA now supports TLS enabled Redis repositories.

(306097)
• In ESCWA, the Process ID column has been added to the table on the Dynamic Debug page. See

Dynamic Debug in your product Help for more information.

(350029)
• In ESCWA, a new PAC Client List page has been added. This page displays a list of PAC members

and associated information. See PAC Client List in your product Help for more information.

(384037)
• An alternate index has been added to the non-recoverable temporary storage file TXTSNR. This is to

enable queues to be returned in alphabetical order when browsing with INQUIRE. When warm starting
non-recoverable TS, if TXTSNR has only a single key then the file will automatically be upgraded to
include the alternate index. If there is a problem during the upgrade process then message CASI1405S
will be written to the console indicating the failure and that the enterprise server region will fail to start.
In this case, the file will either need to be repaired or temporary storage will need to be cold started.

Note: Once TXTSNR has been upgraded it can no longer be used on an older version of the
product that does not contain this fix.

02441509 (389045)
• Corrected the spelling for the db_server_name Configuration Manager property. You will need to

update existing 8.0 enterprise server region configurations by either applying any change on the
ESCWA General >Advanced page, or by updating the mfConfigManagerData MFDS property
through the ESCWA API. If this is not performed, the warning message CASCF0071W
Configuration Manager - The requested property (db_sever_name) was not found
will be displayed in the Console log during region initialization. This will not cause any issues if the
Region Database Server Name property was not previously used, or if it was set though the
ES_DB_SERVER environment variable. Otherwise, you will need to reset this property using the above
methods as the previous configuration for Region Database Server Name will not be honored, which
might result in the region failing initialization.

(350050)
• In the context of a multi-hop Distributed Program Linking (DPL), if the last stage used the default mirror

transaction, its back-end could be left hanging if a SYNCPOINT was invoked by the upstream partner.
This has been fixed.

02432614 02434318 (377071)
• You can now list job steps to enable users to perform advanced restarts. Job steps can be outputted to

JSON by casout /%jnumber. Job steps can be output to a table by casout /%tnumber. See
casout in your product Help for more information.

(401023)
• The Redis server supplied with the product is now version 6.2.6.In ESCWA, you must now specify the

Certificate Authority Filepath, Certificate Filepath, and Private Key Filepath properties on the
Advanced Region Properties page for all enterprise server regions that are members of a PAC that
has a TLS-enabled Redis Scale-Out Repository (SOR). See Scale-Out Repositories in your product
Help for more information.

00373756 (12618)
• During XA recovery, if a resource manager reports an in doubt transaction which has no log entry, a

CASXO0040W message will now be displayed in the console.

(425081)
• If a SOR cannot be connected during enterprise server region start up, then the region no longer starts.

Previously, this only applied to the PSOR, but now applies to other SORs which were only used for TS
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and TD queues. This change was made because the previous behavior could lead to queues being
written to different locations (SORs or disk) across the PAC. If a PSOR cannot be connected during a
process start up when the region is already running, then the process will be blocked until the
connection can be established. Retries will be attempted at increasingly longer intervals. If a (non-
PSOR) SOR cannot be connected to at process start up when the enterprise server region is already
running, then the process will continue to start up. At queue access time, for a queue that must go to
that SOR, the connection will be retried. If this is unsuccessful then the command will receive an
IOERR.

02399193 (356005)
• ESMAC is disabled by default. ESMAC can be enabled from the Advanced Region Properties page in

ESCWA.

(397027)

File Handling

Back to the list

• The SQL Server ENQ/DEQ implementation has been modified to eliminate any possibility of ENQ
request failures occurring due to an intermittent Service Broker problem. The new implementation
introduces a new ENQ stored procedure, and modification of the existing DEQ one to allow it to work
with both the Service Broker and non-Service Broker implementations.

(285197)
• The OPEN EXTEND operation now follows the behavior expected from the OPEN statement as

documented.

02454638 (386087)

Micro Focus Directory Server

Back to the list

• The External Security Manager (ESM) checks did not occur when an enterprise server region started or
stopped. This has been fixed.

02402188 (355001)
• To query Enterprise Server security configuration information (details of configured external Security

Managers and so forth) from the Micro Focus Directory Server when access is restricted, the authorized
Enterprise Server user must have at least Read permission for the Enterprise Server Administration
resource class User Administration entity.

(285199)
• Micro Focus Directory Server now restricts access to enterprise server regions that a signed-on user is

not authorized to view.

02305916 (285169)
• Four new MFDS-only audit event codes (2 300, 2 301, 2 302, and 2 303) have been added. See Audit

Event Codes in your product Help for more information.

02412285 (365149)

Run-Time System

Back to the list

• By default, CTF information no longer appears in AUX Trace of an enterprise server region. To enable it,
you now need to set mftrace.emitter.es#level in the MFTRACE_CONFIG.

(328008)
• If an error occurs during thread clean-up, the runtime will now attempt thread clean-up again. If it fails

for a second time the runtime will call _exit() to terminate the process immediately.
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02286519 (258130)
• On UNIX platforms, when linking using the cob command in place of ldpli, you must include all of the

specified ldpli -l options on the cob command line. 

(410018)
• Attempting to call COBOL functionality after calling the cobtidy() API, to de-initialise the COBOL

RTS, will now result in a COBRT090 error message.  Previously it was documented that the results
were undefined and it could cause subsequent problems, and/or errors, especially in a threaded
environment.  The aim of this change is to give a more meaningful error message, earlier, to help
diagnose such issues.

(301136)
• The limit for the MAXGENERATION emitter property (for both BINFILE and TEXTFILE) has been

increased from 10 to 100. The file size limit for each of these generations, as set by the MAXFILESIZE
property, is 1000000KB.

02405466 (359001)

Setup Issues (Windows)

Back to the list

• Micro Focus Host Access for the Cloud emulator replaces the Micro Focus Rumba+ Desktop emulator
previously supplied with the installer for Enterprise Developer for Eclipse or Visual Studio. Customers
that have Rumba+ Desktop entitlement can continue to use it within Rumba+ Desktop.

(335003)
• In Windows 11 it is now possible to open COBOL 32-bit and 64-bit command prompts from the Terminal

application.

(421016)
• On Windows, you must uninstall earlier versions of this product before installing 9.0.

(380028)
• 32-bit Windows is no longer supported.

(382034)
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• The Server Core form of Windows Server 2019 is not supported.

• In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Visual COBOL 6.0 and later, the .NET COBOL and JVM COBOL run-
times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a version
5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue, you need
to recompile any programs that use this construct in the newer versions of Visual COBOL.

Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 or
later are not affected.

• On the Solaris platform, Enterprise Server Common Web Administration (ESCWA) cannot enable the
External Security Facility (ESF). This results in ESCWA failing to enable user authentication and
authorization. However, you can still enable authentication and authorization for the Micro Focus
Directory Server (MFDS) and corresponding enterprise server regions.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• Application Workflow Manager
• COBOL Language Server
• Code Analysis
• Codeset Support
• Common Communications Interface
• Compiler
• Containers
• Database Connectors for Visual COBOL
• Data Tools
• Debugger
• Dialog System
• Documentation
• Eclipse IDE
• Enterprise Server
• File Handling
• Micro Focus Common Client
• Micro Focus Cryptographic Library
• Micro Focus Directory Server
• Micro Focus License Administration
• Run-time System
• Setup Issues (UNIX)
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: OpenESQL
• XML Support

Application Workflow Manager

Back to the list

• Text area dialog fields are now checked after the dialog OK button is clicked. An error message appears
in the dialog description area if the max line or chars per line is exceeded.

02472205 (394108)
• In the default MVS file mapping, the local code page value for the data set template *.AWMMODEL* is

set to UTF-8. As the default file mapping is only effective for a new workspace, Micro Focus
recommends that you change the local code page value in the file mapping for *.AWMMODEL* from
DEFAULT to UTF-8 in existing workspaces manually.

(380032)
• Local file copying from the MVS Explorer are now encoded and saved with the connection local code

page.

02070256 (207007)
• Else (If) action descriptor statements did not always work as expected when multiple If statements were

specified. This has been fixed.

02287350 (259118)
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• If a property of type SelectValue with unspecified Label Keys was used as a non-editable modeled
dialog field, this resulted in an exception. This has been fixed.

02345550 (297117)
• The new attribute Local File Encoding has been added to the Operation System function package.

See Attributes for the Operating System Function Package in your product Help for more information.

(204054)
• Calling z/OS functions (Submit JCL to z/OS) before establishing a connection can now be executed

without error.

02258259 (256018)
• Using the Eclipse function package AWM tool Create Resource to update the location of linked folders

sometimes resulted in their being removed from the project dependency paths. This has been fixed.

02340680 (296046)
• z/OS data sets with volume serial ARCHIVE were not detected as migrated. This is now fixed.

02532719 (443003)
• AWM Modeling Support 8.0 was tested against IBM IDz v16.0 based on Eclipse 4.23. It can be used

with an IBM z/OS connection. There is a known issue using AWM Modeling Support 8.0 in IBM IDz 16.0
together with a MFA z/Server connection when trying to connect. Using an MFA z/Server connection is
not possible with Modeling Support 8.0 under IBM IDz 16.0.

02486829 (400021)
• Empty string values in the deprecated Affected Resource Name attribute sometimes resulted in

unexpected behavior when executing modeled actions. This has been fixed.

02367680 (314010)
• Parallel evaluation of modeled enabled conditions (for example, in modeless action descriptors) could

lead to unexpected behavior. This is now fixed.

02406754 (364046)
• The AWM master configuration now enables you to specify a URL as the platform under the keyword

Conf which points to an AWM model accessible via an http(s) link.

01825646 (123020)

COBOL Language Server

Back to the list

• Some performance issues when requesting workspace symbols in large workspaces have been
resolved. The operation is now limited to files that are open or parsed.

02384141 (338011)

Code Analysis

Back to the list

• MFDASMX no longer crashes when download process is initiated.

02411250 02427959 (363118)

Codeset Support

Back to the list

• The DISJOINING clause now works as expected when a DBCS hyphen is specified as part of the prefix
or suffix.

(296145)
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Common Communications Interface

Back to the list

• A handle leak on failed ISC connection attempts has been fixed.

02413198 (381021)
• TLS connections failed when a trust anchor was not specified. This has been fixed.

02534509 (446004)

Compiler

Back to the list

• An 013-R error generated on compilation has been fixed.

02501331 (401125)
• JVM COBOL only. Some large and complex programs that used the DECLARE syntax gave a Run-

Time System error of the form:    java.lang.VerifyError: Local variable table overflowThese programs
now give a Compiler error of:    15-S Procedure division too large  

02379096 (335018)
• Within Eclipse, a program with an empty PROGRAM-ID in a JVM COBOL project no longer causes the

IDE to close.

(445004)
• A new directive, ILSTRINGLOAD, is now available for JVM COBOL programs, which can help in

situations where a program with a very large number of distinct alphanumeric literals causes internal
limits to be exceeded in a class (and at which point, an error is generated). Use the directive to create
these literals in a backing file, which can then be converted to strings at run time.

02170649 (380058)
• A program containing a debug line as its first line of source now compiles with an expected syntax error,

rather than a Compiler crash.

(306070)
• Querying the subordinate items of a group defined in a DECLARE statement now works as expected.

(414100)
• Debugging of a program with a copybook located via COBCPY, where the value of COBCPY is

extremely long, now works as expected.

02298722 (276005)
• Using a PROPERTY as a call parameter now compiles and executes as expected.

(5357)
• A query expansion of OCCURS DEPENDING ON tables now correctly reflects the current size.

02500813 (405134)
• The Outline view in the IDE is now available for all programs, irrespective of syntax errors encountered.

02297623 (285151)
• An ALLOCATE statement RETURNING a subscripted pointer now executes as expected.

(369004)
• An ADD .. TO property statement now executes as expected.

(6503)
• The 'AT END' phrase of a file statement is now correctly distinguished from dereferencing syntax

specified in the same context.

(6149)
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• The CP preprocessor now respects the setting of the SOURCE-ENCODING Compiler directive.

02463619 (394012)
• Reference modification with an implicit length on the result of an intrinsic function now executes as

expected.

02269123 (258090)
• A MOVE CORRESPONDING statement with nested subscripting now executes as expected.

02473286 (395097)
• A background parse of COBOL source containing illegal code and characters before the main COBOL

program now produces full syntax checking consistent with previous releases.

02393247 (352074)
• INSPECT .. REPLACING more-than-one-byte BY SPACE is now producing the expected execution

results.

02521582 (411107)
• The CP preprocessor now correctly expands copybooks when COPY REPLACING is active and the

copybook name partially matches the replacing text.

02541659 (427024)
• A COPY REPLACING statement that results in a replacement line of more than 256 bytes is now

processed as expected.

(301078)
• Programs called with a CHAIN statement, which use their own file handler to access the filename

pointer in the FCD, now execute as expected.

(286017)
• A query of an item in a variable-length group with an UNBOUNDED table now returns the correct value.

02500660 (403177)
• Error message COBCH1554 More than 65535 statements in a paragraph. Cannot

produce debugging information is no longer reported for compilations where debugging
information was not requested (i.e., NOANIM specified).

02525192 (415062)
• A CALL statement using the 'DATA AT' syntax to pass a dereferenced parameter BY REFERENCE now

compiles and executes as expected.

(351091)
• The user responses for the ERRQ Compiler directive are now all respected correctly.

(350010)
• COMP-1 and COMP-2 data types compiled with DIALECT"ACU" now receive a syntax error when a

PICTURE description is absent.

(296032)
• When the LANG environment variable is correctly set to match the source encoding of the COBOL

source file, the Compiler now completes the compile successfully.

(390023)
• The DIALECT"MF" Compiler directive no longer affects the user-specified setting of the SETTING

directive.

02449496 (390008)
• A STRING statement with 'DATA AT' operands now executes as expected.

(260018)
• Level 88s defined in a typedef may now be referenced through pointer dereferencing.

(377067)
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• $if syntax is now processed correctly in all cases.

(318040)
• When using a typdef-item at pointer that was not unique in the typedef group, the Compiler compiled

without error; however, the pointer sometimes dereferenced at the incorrect address. This scenario now
produces a COBCH0005-S User-name not unique error message.

(415140)
• The DISPLAY-PICU(UTF-8) option now operates correctly with OUTDD when using Enterprise Server.

(297005)
• A new Compiler directive, ALPHA-LIT-CONT, determines whether continuation of non-numeric literals

includes spaces up to the right margin, or simply to the end of line.

(380072)
• A DECLARE value can now be expressed as an arithmetic expression in native COBOL.

(386138)
• The INITIALIZE condition-name syntax erroneously compiled without error. This now correctly

returns a syntax error for all scenarios.

02468662 (394064)
• An INSPECT statement used inside a class method no longer causes generation of invalid .NET or JVM

code. (This problem did not apply to procedural COBOL programs.)

02504599 (403183)

Containers

Back to the list

• We strongly recommend that you create Micro Focus base product images with the bld.sh script using
the provided Dockerfile/Containerfile. Images created using alternative methods might fail with the
message 245 There are no valid product licenses unless the image includes the
CONTAINER environment variable. This release ensures that the provided Dockerfiles/Containerfiles
include this environment variable.

02555217 (439070)

Database Connectors for Visual COBOL

Back to the list

• When accessing a SQL Server table with Database Connectors, and when the primary key allowed
duplicates (which is not recommended), the interface sometimes incorrectly handled a direct READ,
especially when it was followed by a READ NEXT. This has been corrected.

02336856 (297028)
• The following issues that occurred when a primary key allows duplicates have been fixed:      

Rewriting or deleting a row sometimes affected more than a single row.     
Executing READ followed by READ NEXT returned the wrong record.  

To use this fix, both of the following conditions must be met:

• An identity column must be included. This can be either a hidden column using A-MSSQL-ADD-
IDENTITY when the table is created, or an explicit column using the IDENTIY-COLUMN XFD
directive. 

• The record to update or delete must be the last record read.

Failure to meet either of these conditions results in run-time error code 9/7. See Run-Time System
Errors in your Visual COBOL Database Connectors documentation.
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02324219 (285156)
• All special characters used in a user name or a password must be surrounded by {} brackets. If the }

closing bracket is used as a special character, it must be doubled to escape it. For example:

my{@}user{}}name

Translates to:

my@user}name

02393584 (352036)
• When doing a REWRITE or a DELETE on record that was constructed by the COBOL program (as

opposed to having just READ the record), the wrong record could be affected. This has been corrected.

02497731 (401111)

Data Tools

Back to the list

• The Data Tools editor could display incorrect record numbers for variable sequential files following a
Find operation. This has been fixed.

02516058 (411005)
• In the Data Tools editor, there was an issue with viewing the last page of records in a sequential

variable file when the Quick final page preference setting was enabled and the file was defined with a
minimum record length of 0 or a large variable record size range combined with a large Records per
page preference setting. This has been fixed.

02487096 (397034)
• The performance of the Search > Go To navigation feature of the Data Tools editor has been improved

for variable and line sequential files.

02399254 02480008 (399043)
• Editing/deleting line sequential file records no longer hangs when using Date File Tools.

02239120 (259127)
• When attempting to open data sets in the Data File Editor, file names containing a $ sign are no longer

incorrectly trimmed.

02194216 (221086)
• Data File Tools no longer attempts to open unrecognized file formats. Instead, an error message

appears explaining which format is invalid.

02308449 (281015)
• You can now copy hex values of selected records from the unpacked rows at the bottom of the screen

using the Copy Hex option available on the context menu the Edit menu. This option is visible only
when the hex toggle is enabled.

02396732 (352067)
• When copying a record to an external destination, the NULL Byte character is replaced by a character

specified in the Preferences dialog box. The default replacement character is a period (.).

02396678 (350053)
• The Toggle Hex function now shows hexadecimal values under each line in the editor, not only the

selected one.

02342260 (297080)
• Field values of the Data File Tools File Information dialog box can be selected and copied to clipboard.

02396730 (352047)
• Horizontal scrolling in files with variable-length records did not work as expected when a short record

was selected. This is now fixed.
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02150974 (202028)
• It is now possible to start mfdatatools2 from the command line to open a catalogued file from an

enterprise server region.

00501248 (71267)
• In the Data File Editor, a preference has been added to specify the maximum number of requested data

sets in the Data Explorer view. If a catalog contains more data sets than the maximum requested
number, a More data sets in catalog stub appears at the end of the list.

02396657 (350052)
• You must configure a TS model to ensure that Data File Editor correctly honors file locking across all

enterprise server regions in a PAC.

02529725 (413062)
• Previously, the DFCONV utility would produce an error when converting sql:// database files. This

has been fixed.

02497741 (403103)

Debugger

Back to the list

• Debugging a statement that goes up to column 255, with the Autos window active, now works as
expected.

02289017 (271031)
• Expanding a dereferenced group item in the debugger now correctly shows the data for subordinate

items.

(363158)
• Previously, CBL_DEBUGBREAK did not invoke the debugger in .NET COBOL applications. This has

now been fixed and the built-in "Choose Just-In-Time Debugger" dialog box appears during invocation.

02388923 (348042)
• An issue has been fixed where the list of processes for 'attach to process' debugging could be displayed

incorrectly.

02458536 (386153)

Dialog System

Back to the list

• An issue with the dialog system painter clearing the screen when resizing a control has been resolved.

02367685 (330012)

Documentation

Back to the list

• Enterprise Server security configuration options have been updated. See Security Configuration
Custom Configuration Information in your product Help for more information.

(411024)
• Information on configuring an OpenLDAP server has been updated. See Configuring the OpenLDAP

server in your product Help for more information.

02387889 SF:02437494 02437494 (356021)
• The CASESM Security Manager was part of the legacy security model used in the Net Express and

Server Express 5.0 and earlier products. As part of this, the legacy ESMAC user interface pages had
Security Keys as configurable options. In ESCWA, these can only be accessed by the Client Web API

24 | Resolved Issues



and are not available in the ESCWA user interface pages that are equivalent to the corresponding
ESMAC pages.

02276034 (259095)
• The OSESM tracing option has been added to the configuration information in the product Help.

02145921 (202197)
• Setting ES_PRODUCTION=Y will prevent debugging on Enterprise Server regions.

02208272 (346026)
• The documentation sample in the Using CobolBean for Instance Data Java topic has been corrected.

(409036)
• UNIX documentation has been updated to correct the case of the mfcatxml command.

02386876 (335024)
• The product documentation has been updated with the current name and contact information for Micro

Focus Customer Care. Any instance of the older terms for customer support remain in the
documentation because it is present within the product itself.

(377012)
• The SQL Server RM Switch Module topic has been updated to remove the [directives] option for build

mssql. The option is not valid and ignored by the system.

3172383 (13152)
• The documentation has been corrected to describe the duplicate cursor effect.

3172533 (11320)
• The product documentation now correctly states PF_RO_CURSOR=8 as default when using

BEHAVIOR=MAINFRAME with SQLServer.

00372417 (12688)
• The documentation has been corrected in respect to enabling JIT debugging in Eclipse, on Linux\UNIX

platforms.

(365015)
• The To convert Net Express projects to Eclipse projects cheat sheet is no longer available on UNIX-only

products.

(238031)
• The documentation has been updated to highlight the requirement of associating a region with a project

if that region was created using one of the available enterprise server templates.

02152983 (256022)
• Instructions have been added to the Documentation that detail using Ant to build selected files in a

project, from the command line.

02212776 (304089)
• The sample Java code in the documentation topic Examples of Calling COBOL From Java  has been

corrected.

02509559 (405065)
• The documented description of the SSH Only remote host connection has been amended to explain the

limitations when using the Console view for output.

(464063)
• Some minor documentation amendments have been made to the IMTK tutorial SOAP Web Services.

(415185)
• An entry has been added to the Containers known issues and restrictions documentation concerning

memory issues under Windows 10.

(297140)
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• Some of the COBOL cheat sheets in Eclipse have been updated/corrected.

(238037)
• Error message text for COBCH1882 in the has been updated.

(425030)
• The Data Files Tools tutorial has beenupdated to correct import instructions in Eclipse.

(319006)
• The documentation has been updated to show that only under an MF dialect can you omit the Working-

Storage Section heading.

3245726 (28060)
• The documentation has been updated to clarify support for the following: the CBL_GET_ERROR_INFO

and CBL_CREATE_STACKDUMP library routines, the stackdump_on_error tunable, and the
cobgeterrorinfo function.

(385041)
• The cob command examples in the documentation have been updated.

(403044)
• New documentation has been added that gives more detail on how to use the CBL_CTF_* library

routines. See Using the CTF Library Routines in the product documentation for more information.

(264040)
• The Micro Focus Unit Testing Framework documentation has been updated to explicitly state that the

MFUPP preprocessor is intended for use only within the confines of the testing framework.

02259026 (258085)
• Some of the screen shots in the MFDBFH documentation have been updated to show MFDBFH-

specific URLs in ESCWA.

(301083)

Eclipse IDE

Back to the list

• A problem that prevented command-line-based code analysis rule execution from completing
successfully was identified in the generation of linked resource information in the COBOL build files.
This has been fixed.

(297077)
• An issue was identified where compiling dependent programs of a specified copybook could fail when

dependencies spanned project boundaries. This has been fixed so that all dependent programs can
now be built.

02514846 (421007)
• A code issue was stopping the SQL preprocessor from being used when the initial indexing phase was

being run after project import (a process that determines the copybook usage), when no .idy files
were present. This has been resolved so that the preprocessor should now be invoked and copybook
usage information harvested.

00470009 (58319)
• A problem was identified with the paste functionality in the COBOL editor when Smart Edit Mode was

enabled, where the paste operation was not correctly taking into account the source format of the
document being edited (and so attempted to preserve the right margin when it shouldn't have been
doing so). This has been resolved.

(365196)
• An issue has been resolved where enterprise server region XML files were failing to import when using

the IDE-generated Dockerfile and associated script.
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02398225 (364091)
• An issue has been resolved where the Configure Enterprise Server Run-time Environment dialog

box no longer adds an extra entry into the .rtc file, which was causing it to be invalid according to the
XML schema.

(393143)
• An issue has been fixed where hover text sometimes did not work when debugging source files from a

network share.

02213842 (251008)
• The generated Dockerfile helper scripts have been updated to use the --replace flag when calling

mfdepinst.

Note: If there is a pre-existing helper script in the project, it will need to be deleted before re-
running the New Dockerfile Wizard to generate the new script.

(362004)
• The generated Dockerfile helper scripts have been updated so that they fail a Docker image build when

an error is encountered.

Note: If there is a pre-existing helper script in the project, it will need to be deleted before re-
running the New Dockerfile Wizard to generate the new script.

(364010)
• Subscripted variables are now displayed correctly in the Variables window. Previously, they did not

when the debugging source files did not match the location specified in the IDY file (i.e., the source files
were moved after compilation).

02214996 (271021)
• Colorization of string literals in the COBOL editor has been improved. Text is only colorized as string

literals within the code area and not within the left or right margin.

(10010)
• Generated dockerfiles may contain entries for installing xterm into the image. This is to enable certain

debugging scenarios.

(301110)
• Within the JVM COBOL debugger, a variable-length field now shows the odoslide optimized data.

02167560 (220023)
• An issue when evaluating COBOL table elements nested in grouping variables, with subscripts, has

been fixed.

02028149 (346031)
• The Run to Line debugging option has been added to the context menu of the COBOL and the COBOL

Copy View editors when debugging COBOL JVM projects.

02229815 (301049)
• Run to line debug support is now available for JVM COBOL projects.

02229815 (246120)
• An issue where the cursor jumps to a breakpoint line when hovering over variables has been fixed.

02407213 (363025)
• The Extract to Copybook option now flags file names that include apostrophes as invalid.

(7248)
• Within Eclipse, conditional fields are now updated in the Variables and Expressions views after an

update of a related elementary field.

02296412 (258266)
• The version of Ant that is shipped with COBOL development products is now version 1.10.12; at the

time of writing, it does not have any reported vulnerabilities.
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(296038)
• An issue has been fixed so that enterprise server regions now correctly show their output console

information. Previously, where regions had stored credentials at the time the IDE was started, they
would fail to output any console information.

(258191)
• Error messages are now parsed correctly so as to avoid crashing the IDE.

(427004)
• The Console view in Eclipse now correctly shows information for an enterprise server (if the credentials

are valid).

(409082)
• JVM COBOL local variables are now shown in the Variables view during a debug session.

(393091)
• Within Eclipse, when generating a client COBOL program for a web service, the Bit Mode and Charset

properties are now honored correctly.

02483744 (397005)
• The Automatically find new updates and notify me preference is turned off by default to prevent a !

MESSAGE Unhandled event loop exception. Several default update sites have also been removed
during installation.

02319011 (285069)
• In the Eclipse editor, if the vertical or horizontal split functions are enabled and then removed, syntax

highlighting continues to work. Previously, you were required to reopen the source file for syntax
highlighting to work.

02328546 (297008)
• A new option enables you to set COBOL keyword conversion to upper case, lower case, or as-is during

Code Cleanup.

(451073)
• Support of Micro Focus base images has been improved by adding a new wizard page to allow users to

select the base layers used in a generated Dockerfile.

02398225 (365108)
• You can now set conditional breakpoints within JVM COBOL programs; see Setting conditional

breakpoints and watchpoints  in your product Help for more information.

02178115 (355027)
• Dependency was not being updated when source files were modified external to the Eclipse IDE. This

has been addressed by a new option in the preference (Micro Focus > General) which, when selected,
updates the information when the resource is refreshed using the Refresh context menu item or by
pressing F5 on a resource in the explorer views). The dependency information will also be updated
when the file is open in an editor window and is modified externally.

02445610 (393008)
• The values of COBOL JVM variables can now optionally be displayed as hexadecimal values and byte

values. The inclusion of these value formats can be configured using the Value display options group in
the Micro Focus > Debug preferences page.

02229819 (246121)
• A problem that prevented the UnGroup menu option from being enabled has been fixed. Ungroup is

enabled for group items only. It removes the current group and places its group children one level
above.

02356137 (307002)
• Table variables in JVM COBOL programs are now displaying the correct value for subscripted and index

fields, both in the Expressions view and in hover mode over the variable. Also, table variable values are
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now automatically changing in the Expressions view when the index is updated. The supported
expressions are:

- data-item(numeric)
- data-item(counter-data-item)
- data-item(operand operator operand)

Where operator is an operator for arithmetic operation (+, -, *, /) and operand is numeric or counter-
data-item. Multidimensional tables are also supported.

02153242 (203116)
• A new option has been added to the Search view for COBOL JVM projects - COBOL JVM Search

Presentation. It toggles between two types of presentation of the data: one that you may be familiar
with when working with Java projects, and one familiar when working with COBOL projects.

02290437 (259158)
• For COBOL JVM projects, the Variables view now shows the value of the first 32 bytes of the memory

block pointed by the pointer. Also, a new pointer expression is available in the Expressions view for
COBOL JVM projects (this was already available for native projects): expression data(x:y)my-
pointer at my-pointer queries the memory block pointed by the pointer, where x is the starting
offset of the memory block, y is the number of bytes to query and my-pointer is the name of pointer
variable.

02153242 (321036)
• A new option, Refresh Service, has been added to the Web Services and Java Interfaces context

menus. Use the Refresh Service option to update the bitism of the program for an existing Web
Service or Java interface after changing the bitism of the Eclipse project or the COBOL program.

(294014)
• A new option is available from the X Font preference of the Preferences > Micro Focus > Debug

dialog box: select Use X Server font from the drop-down list to ensure that the application being
debugged through the X window uses the default font configured for the X Server.

02410279 (363047)
• If you attempt to create a self-contained unit test for a program that is already under test for an existing

self-contained test in that project, you are prompted to overwrite the existing test or select a different
program to put under test.

(222044)
• A new option that enables you to export code coverage results in a .tcz file has been added to the

Code Coverage view in Eclipse.

(5183)
• A new preference is available that, when selected, automatically adds line numbering to your program

when it is saved. This preference negates the need to use the Renumbering option when editing a
program that already has line numbering in place. The preference Perform line numbering on save is
available from Window > Preferences > Micro Focus > COBOL > Editor > Line Numbering.

02285269 (260138)

Enterprise Server

Back to the list

• Now users who have overlapping long names like USER1234 and USER12345 will not have overlapping
permissions when they have distinct mapped short names.

02529441 (440070)
• In Enterprise Server External Security Facility (ESF), requests to generate a passtoken (including for

RACF-style passtickets used by DCAS) could sometimes be rejected as unauthorized attempts to
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create surrogate passtokens even though the passtoken request was not for a surrogate. This was due
to a case mismatch between the request and ACEE. This has been fixed.

02433532 02442474 (399097)
• The ESF could corrupt the credentials used to connect to an LDAP server when auditing was enabled,

causing a critical security failure and preventing enterprise server regions from starting. This has been
fixed.

02518028 (415116)
• MLDAP ESM now supports the use of the mfsecret: syntax for retrieving the security manager

credentials (authorized ID and password) from the vault. Those fields in the Security Manager definition
in ESCWA can be specified using the forms:

        mfsecret:configuration-name:secret-path

or:

       mfsecret:secret-path

02548082 02554256 (440042)
• Mfsecrets crashed when running as multithreaded. This has been fixed.

(381004)
• A problem that prevented the AES provider on big-endian platforms from correctly reading vault secrets

has been fixed.

(430032)
• An incorrect signal 11 was generated from mfsecrets when getting the username for audit. This has

been fixed.

(382026)
• For Enterprise Server LDAP-based security, two new options, [Operation] group membership uses

short name and [Operation] search users by short name, permit applying user and group data to
users known to that Security Manager only by their short name (the Enterprise Server user ID). See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

02344601 (301036)
• In ESCWA on the Catalog page, you can now use the Line Wrap switch to toggle line wrapping for long

lines.

02289615 (258187)
• The ESCWA SEPs page displays Transient and Debug SEPs.

(327011)
• In ESCWA, accessing the Catalog file data has been improved by modifying the page layout.

02154749 (202107)
• In ESCWA, focus would not be put into modal dialogs when opened. This has been fixed.

01995433 (156067)
• ESCWA now displays more clearly when operating in Windows high contrast mode.

01995438 (161036)
• In ESCWA, the maximum height of list menus have been limited so that they do not overflow the screen

from their position, with a scroll bar to access all items.

02499988 (403117)
• In ESCWA, the SEP List page did not correctly sort the list by ascending or descending order. This has

been fixed.

02382568 (352007)
• ESCWA was not able to bind to a hostname containing the w character. This has been fixed.

(296023)
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• The ESM password is no longer disclosed in the /esf endpoint request.

02554256 (450046)
• Reduced the number of password save prompts encountered when navigating ESCWA using the

Firefox Web browser. 

02324422 (306001)
• In ESCWA, the FCT Backward and Forward Recovery will no longer be disabled when Use Catalog is

selected.

02416596 (364107)
• When ESCWA was configured for TLS, it failed to stop when using escwa --shutdown from the

command line. This has been fixed.

02405704 02004795 (365071)
• Added missing annotation for ESCWA trace point.

02538486 (415187)
• ESCWA had duplicate CTF trace IDs. This have been fixed.

02524827 (409072)
• In ESCWA, the additional column File Size has been added to the catalog list view.

(403123)
• ESCWA might fail to disconnect from a Redis instance and reconnect to another. If this occurs you can

manually trigger a reconnect action by clicking the Reconnect button on the Scale-Out Repository
Information page.

(363105)
• If ESCWA auditing is enabled from the Configuration page, or when ESCWA ESF auditing is enabled

from the Security > ESCWA Configuration page, then an auditing event is emitted, 2 19 (auditing
stopped), or 2 20 (auditing started). See Audit Event Codes in your product Help for more
information.

02412285 (365156)
• In ESCWA, you can now rename catalog data sets from the Catalog page. See Adding and Editing the

Catalog Entry in your product Help for more information.

02501074 (403136)
• In ESCWA, the “Historical Statistics Detail for Transaction” and “Historical Statistics” pages now

display time in milliseconds and the accuracy for latency and response information has been improved.

02504559 (405096)
• A new CGI threshold type has been implemented in Enterprise Server. This enables you to set up

threshold values for ESCWA and ESMAC requests by applying the global =CGI to all ESCWA and
ESMAC requests, or by specifying the corresponding casrdo or casrdj module that you want to
control.

(377073)
• MFDS no longer supports XA reconnect attempts.

(427068)
• In ESCWA, the PCT Security flag is now displayed on the Active PCT page. See Active PCT in your

product Help for more information.

(335002)
• Resolved an issue with a mutex deadlock created when MFDBFH attempted to emit a message during

a cascd shutdown. 

02468209 (406002)
• A problem that caused Web Service client calls to fail after an upgrade has been fixed.

02320601 (307054)
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• An intermittent Access Violation in mfredis.dll sometimes occurred when a batch job abended. This
has been fixed.

02328218 (296144)
• ECI transactions were not being committed at the end of task. This has been fixed.

02497005 (403085)
• An issue that resulted from pressing the Clear key following a EXEC CICS SEND PAGE command has

been fixed.

02423737 (375058)
• The recovery of processes by casmgr now occurs in the same order in which they were terminated.

02449487 (389051)
• A bitism issue with the triggers provided with the product has been fixed.

02554978 (449002)
• An issue with updating a transaction ID in ESMAC has been fixed.

(264059)
• A WEB RECEIVE SESSTOKEN sometimes threw an RTS 114 error in cascwi. This has been fixed.

(409046)
• Dynamically enabling HSF sometimes resulted in shared memory corruption. This has been fixed.

(411104)
• In a PAC, closing an FCT that referenced a catalogued file sometimes resulted in a truncated filename

after 44 characters. This has been fixed.

02421476 (364152)
• The casfile, casout, casstop, cassub, castran, and casutl commands now find the enterprise

server region successfully when mfds is started with the -b option.

02307940 02202467 (286003)
• An error message was unnecessarily exposing input credentials. This has been fixed.

02409369 (363126)
• When using casout, the /y option could fail depending on the order of options used. This has been

fixed.

02371843 (313041)
• An internal transaction (ITR) was not sent to a SEP that had an EZASOKET listener started. This

sometimes resulted in a close file request failing to be processed by the SEP running the EZASOKET
listener. This has been fixed.

02394276 (350047)
• When an XA issue occurred, the reason code was not always returned. This has been fixed.

02532560 (425053)
• An intermittent crash in casmgr has been fixed.

02431740 (377040)
• When performing a NEWCOPY on a data table in a PAC, not all enterprise server regions in the PAC

reloaded the new member. This has been fixed.

02406797 (364015)
• Thresholds are now started before the XA start for a transaction has been issued, enabling the process

to be killed if the transaction is stuck in the Resource Manager.

02365811 (306124)
• When using the CICS command castran with the -b option, the message was not sent to the

console.log file. This has been fixed.
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02389970 (348041)
• When multiple requests were made from the same browser, a new TCTS was allocated, resulting in an

SOS situation. This has been fixed.

02419170 02404921 (364124)
• When using TRANCLASS and refreshing ESMAC, the data sent to a started transaction could be lost,

resulting in ENDDATA returned on the retrieve. This has been fixed.

02526457 (451029)
• The sample exit program DFHUSYNC has been modified to not return cics-syncpoint-normal-88 by

default as this could overwrite the correct return-code set on a previous call to an RM.

02492604 (409026)
• The RAS process is now correctly identified on a dump.

(385051)
• Fixed a memory corruption that occurred when logging in-doubt XA transactions in the PAC.

02304565 02319810 (284038)
• Replaced ESF Admin API LISTRESOURCE with ESF Auth for querying MQ Security Resources.

02154003 (202145)
• Updated XID generation to support UTF-8 code pages with PostgreSQL.

02296723 (273006)
• A shared memory corruption issue occurred when reinstalling a TCPIP Service or URIMAP. This has

been fixed.

(204047)
• Improved error reporting when applying advanced configuration updates in a PAC environment.

(364113)
• The casesxml utility now provides a relevant error message when no work location is provided.

02531150 (413115)
• The casstop command output misleading error messages when immediate shutdown was used. This

has been fixed.

02490512 (403132)
• The dynamic region configuration updates occasionally failed to apply. This has been fixed.

(245030)
• If an enterprise server region contained $ES_SERVER in its configuration, then it would not be handled

by casesxml. This has been fixed.

02531150 (417037)
• To improve efficiency, when an enterprise server region is configured with multiple RMs and a task uses

only one, no XA log is created for the transaction.

02537701 (430016)
• When calling APPC functions, you could pass an invalid value in the first parameter which would result

in an error in the communications server layer. This has been fixed.

02428147 (372009)
• When using LU6.2 communications infrastructure between enterprise server regions, when a COMMIT

was executed by the originator, the target would incorrectly attempt to send a commit request back to
the region which sent the sync point request. This has been fixed.

02339327 (296039)
• When using LU6.2 communications infrastructure between enterprise server regions, the processing of

SYNCONRETURN on a Distributed Program Link was preventing switching between remote systems
(SYSIDs). This has been fixed.
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02336501 (296104)
• When using LU6.2 communications infrastructure between enterprise server regions, an ABEND in the

target region would result in the SEP which was processing the request hanging. This has been fixed.

02287147 (259103)
• A DPL request from Tuxedo over LU6.2 could result in an RTS 114 error being reported. This has been

fixed.

02531060 (421001)
• HSF records for Java ECI transactions now display the transaction name instead of CASECIP.

02338437 02353043 02394280 (296126)
• The latency value in HSF records could be incorrect for transactions started via DPL. This has been

fixed.

02504559 (407143)
• Some Redis connections from castmc, castrc, and cassi processes were not being disconnected

and remained open. This has been fixed.

02198949 (222162)
• The casstart utility now accepts variable wait times for the /w parameter. See casstart in your

product Help for more information.

(365010)
• HSF now reports that 100% of transactions meet performance criteria when no transactions are

measured for that period.

(385065)
• Dynamic Debugging failed on secure enterprise server regions with certain security configurations. This

has been fixed.

02408468 (363059)
• Enterprise Server Clustering is now deprecated. Micro Focus recommends that you adopt the Scale-

Out Performance and Availability Cluster (PAC) solution for your clustering requirements. See Scale-Out
Performance and Availability Clusters in your product Help for more information. In addition, the
LOCKDB feature has been added to replace the functionality of the Enterprise Server Cluster Global
Lock Manager (GLM). See Enterprise Server LOCKDB for more information.

(363157)
• An enterprise server region sometimes crashed after MFCS and the ADMIN SEPs were killed. This has

been fixed.

02415369 (364089)
• A new CGI threshold type has been implemented in Enterprise Server. This enables you to set up

threshold values for ESCWA and ESMAC requests by applying the global =CGI to all ESCWA and
ESMAC requests, or by specifying the corresponding casrdo or casrdj module that you want to
control.

02426463 (370004)
• You can use the new ES_HARD_KILL_PROCESS environment variable to modify how Enterprise

Server kills a process. See General Enterprise Server Environment Variables in your product Help for
more information.

02365440 (355015)
• Added a new Retrieve action to the caspac utility to enable you to retrieve binaries loaded on an SOR.

See caspac in your product Help for more information.

(284104)
• A new /z parameter has been added to the following commands-line utilities: casfile, casout,

casstart, casstop, cassub, castran, and casutl. The parameter enables you to pass user
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credentials through an interactive prompt or a redirection from the console. See the respective
command-line topics in your product Help for more information.

(303013)
• In Enterprise Server with LDAP-based security, the effect of the value 0 for the attribute microfocus-

MFDS-User-MTO-Timeout was documented incorrectly. When this value is 0, the enterprise server
region's default user timeout is used. See Defining a User with LDIF in your product Help for more
information.

02305957 (276010)
• The following environment variables can now be configured as properties on the ESCWA Advanced

Region Properties page: ES_SEP_DORMANT_TIME, CAS_SRV_CANCEL, and
 ES_MAX_CATALOG_LINES.

(348002)
• The following environment variables can now be configured as properties on the ESCWA Advanced

Region Properties page: ES_DDBG_PORT_RANGE, ES_ESMAC_DISP_MAX_OVERRIDE, and
ES_SOR_RETRIES.

(306023)
• The supported list of cipher suites has been updated to TLS v1.3.

02320601 (401139)
• An issue that prevented the user ID from being found and that then failed to report this back to the

application has been fixed.

02459379 (395007)
• When running with futex support, enterprise server regions would no longer start due to a logic error.

This has been fixed.

(308024)
• In TRANCLASS enterprise server regions, non-TRANCLASS Temporary Storage Queue (TSQ)

processing can now be enabled by setting ES_TRANCLASS_EXCEPT_TS=Y.

(387013)
• Support for TS queues of type Exclusive has been improved by correcting error conditions and now

retaining queue recoverability after a DELETEQ.

(386014)
• A bug in the castsc process meant that it could trap in casstore when a terminal disconnects. This has

been fixed.

(368001)
• In a PAC, access to an FCT could immediately reopen an FCT that had just been closed by another

enterprise server region. This has been fixed.

02421476 (375005)
• A WRITEQ TS using the REWRITE option against a non-existent queue was incorrectly returning

ITEMERR instead of QIDERR when running with ES_TRANCLASS_EXCEPT_TS=Y. This has been
fixed.

02515519 (405171)
• An issue with the start initiator button not being correctly disabled when a user was not authorized for

the casout resource (OPERCMDS) has been fixed.

02503261 (401173)
• A loop that occurred when trying to recover PIDs after MFDBFH lost the connection to the database has

been fixed.

02373280 02362273 (322009)
• MQ security was being disabled when Allow unknown resources was enabled. This has been fixed.
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02328521 (288019)
• When a process dies in a PAC, casmgr in the recovery process tries to call MFDBFH to recover the

process, close all files opened by that process, and release all the locks. If the connection to the
database was lost, the call to MFDBFH would fail and the process only recovered if the connection was
restored at region termination. Updates in this release now keep track of the process that could not be
recovered and retries when the connection is restored. On region shutdown, all orphan ITRs that
belonged to the current region are now removed. At start up, all orphan ITRs that were targeted to the
region are removed.

02345487 (303043)
• An incorrect HSF latency calculation when the transaction was using a TCPIPSERVICE has been fixed.

02439855 (387136)
• When using DEFINE LIBRARY, casrdtup was hanging. This has been fixed.

02422104 (372043)
• You can now specify thresholds for ESCWA and ESMAC requests using the new type CGI and by

specifying the casrdxxx module name or a global threshold =CGI. This ends the request abnormally if
the threshold is exceeded, and stops the admin SEPs from being blocked on long requests accessing
ESCWA or ESMAC.

(372055)
• Invalid messages have been removed from the Catalog Display when details are enabled.

02501609 (405074)
• A local memory leak that occurred when logging XA transactions in a PAC has been fixed.

02319834 (285102)
• An issue with MQ security checks when security resource prefixes are used has been fixed.

02483959 (397010)
• Ambiguous MQ security rules failed to enable security checks. This has been fixed.

02375426 (314055)
• The subsystem security switch was not being set to OFF when the MQADMIN class was not defined.

This has been fixed.

02483959 (399003)
• All authentication checks for Dynamic Debugging operations are now skipped if the casdebug entry is

not available under the OPERCMDS security resource.

02367824 (314007)
• An issue with MQ security console messages not containing the actual resource being checked has

been fixed.

02483959 (399002)
• Return code handling for create process requests on Windows platforms has been improved.

02290153 (307032)
• When using LU6.2 communications infrastructure between enterprise server regions, an ABEND raised

by the target application would result in subsequent attempts to establish a conversation to fail. This has
been fixed.

02339327 (297043)
• HSF reported latency for incoming remote DPL requests were not being reported correctly. This has

been fixed.

02455011 (392023)
• Windows Performance Counters now work using a V2 provider DLL and will appear in Performance

Monitor under 'Micro Focus Server System V2'.

(286029)

36 | Resolved Issues



• Security checks are now supported for Dynamic Debugging operations. Checks are carried out against
the casdebug entry under the OPERCMDS resource class.

02337725 (296095)
• When using casesxml, if the enterprise server definition has been exported using the -c option then

you must import using the -c parameter.

(351045)
• An issue with the TType page (Signoff attribute) affecting ESCWA and ESMAC has been fixed.

(402014)
• In ESCWA, the field did not display the correct time. This has been fixed.

02470813 (393069)
• The JSON ESMAC spool details module now reports the UUID of the PAC member which processed a

batch job back to ESCWA.

(293036)
• The ESCWA API call /native/v1/regions/host/port/region/users/resource has been

fixed.

02382647 (340024)
• When using the OpenLDAP client library on Linux, if the Timeout parameter is set in the [LDAP]

configuration section, the MLDAP ESM Module will instruct OpenLDAP to set the
TCP_USER_TIMEOUT socket option to correspond to the Timeout value. This improves OpenLDAP's
ability to honor the timeout. However, the TCP_USER_TIMEOUT socket option only applies when sent
data goes unacknowledged, or data cannot be sent because the server's receive window is closed.

02446931 (387139)
• In some circumstances MFDS incorrectly granted permissions. This has been fixed.

(365086)
• An Enterprise Server Security Manager using the MLDAP ESM Module with caching enabled no longer

incorrectly caches partial results when an LDAP search cannot return the full result set due to the
server's size limit on responses. The module will always switch to an LDAP paged search when
necessary, bypassing the cache. This corrects an issue where customers with a large number of
resource rules might sometimes get incorrect security results (typically access denied when it should
not be) after the first time that resource class was queried.

Note: If you cannot apply this fix, you can work around it by disabling caching for the Security
Manager. ESF caching, which is set in the Security properties for the enterprise server region, can
remain enabled.

02475614 (397047)
• Enterprise Server security did not always assign supplemental groups to users in certain configurations

with multiple Security Managers, Federation enabled, and All Groups enabled. This has been fixed.

02145921 (202146)
• The ability to change passwords through the OS ESM Module was broken in version 1.10.4 of that

module. That has been fixed.

02408023 02417238 (363081)
• Issues with changing passwords through the OS ESM Module have been fixed.

02408023 02425417 (370007)
• When using the OpenLDAP client library on Linux, the MLDAP ESM Module can now optionally set the

connection-specific TCP keepalive parameters (idle time, interval, and number of lost probes before
terminating the connection). See MLDAP ESM Module Custom Configuration Information in your
product Help for more information.

02446931 (385125)
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• For Enterprise Server LDAP-based security, a new configuration option, [Operation] check
constraints for already-verified users, lets an MLDAP Security Manager deny sign-on for a user even
if an earlier Security Manager has chosen to allow the Verify request. See MLDAP ESM Module Custom
Configuration Information in your product Help for more information.

02346703 (297133)
• The esfupdate utility now supports the Micro Focus Vault Facility for retrieving secrets. See To Update

Security Manager Changes Using esfupdate in your product Help for more information.

02510669 (406066)
• When both BATCHONLY and LOCALTX are set to true, one-phase-commit batch jobs no longer trigger

two-phase commit connection in the recovery transaction.

02407338 (364098)
• The XA ODBC switch module now gets the correct server status, enabling the Enterprise Server

RECONNECT feature to work correctly.

02408845 (362020)
• XA switch modules that use OpenESQL now work correctly when the applications in Batch transactions

are compiled with XAID directive option.

02327393 (293012)
• The DB2 switch module now sets the PackagePath after switching to the user.

02269497 (258224)
• XA switch modules no longer return an MFDBFH registration error to Enterprise Server, ensuring that

non-MFDBFH transactions continue using the XA connection.

02452753 (385055)
• The correct OCI_ATTR_SERVER_STATUS is now used to query Oracle Server status.

02391332 (335016)
• XA recovery is now performed correctly for DB2 in-doubt transactions when the enterprise server region

is next started.

02474721 (402001)
• You can now build the SQL Server RM switch module on UNIX platforms. See SQL Server RM Switch

Module in your product Help for more information.

(365126)
• The Region Trace Control process (castrc) was incorrectly creating multiple connections to Redis

after a RD-NOAUTH return code. This has been fixed.

02319798 (335004)
• Intermittent CONNECT_ERROR issues occurred when accessing data from MF Directory Server via

ESCWA. This has been fixed.

02532852 (425068)
• A socket handle leak occurred if the connection to the MF Directory Server process failed. This has

been fixed.

02435329 (382013)

File Handling

Back to the list

• The performance the Data File Editor has been improved when navigating within variable-sequential or
line-sequential files accessed through a Fileshare server.

(401106)
• File Status no longer returns corrupt index file for a non-corrupt file, under high traffic.
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02513640 (406155)
• A COBRT114 error no longer occurs when using read-direct on VB file header records.

02490607 (400074)
• Background changes have been made to the external file handler when dealing with sequential files.

(382072)
• Performance improvements have been made when navigating to the last page of a variable-length file in

the Data File Editor.

02476713 (394163)
• Fileshare could crash when processing some unexpected sequences of operations for a connected

Data File Editor. This has now been fixed.

02409270 (365144)
• In some scenarios, zombie processes could result in an incorrect reporting of open files in the system.

This has now been corrected to better detect when such scenarios occur.

(297118)
• It was possible for an ODBC/OCI exception (such as a connection timeout) to occur in the optimized I/O

thread when accessing files via MFDBFH. This could cause the process to hang, and so defensive
measures have been taken to resolve this.

02481017 (405157)
• An issue where MFDBFH would incorrectly return a 9/139 error when attempting to open a file that did

not have a key definition area specified in the FCD has now been fixed. The behavior is now the same
as it is on disk.

02394334 (350036)
• Oracle statements were previously using deprecated OciStmtPrepare calls, which meant that the

Oracle application failover/transaction replay could not be used. This has been updated to now use
OciStmtPrepare2.

02441885 (384027)
• A timing issue when closing the connection to the database caused an SEP to crash on region

shutdown. This has been resolved.

(254034)
• The time required to return after reading a large number of records from large files hosted in MFDBFH

was excessive due to the large number of SQL queries being executed. These queries have now been
optimized to improve performance.

02396919 (384007)
• Enterprise Server sometimes failed to recover processes that died after losing and then reestablishing a

connection to the database. To mitigate this, Enterprise Server has been updated to attempt recovery of
these processes at a later time in the event that the database connection cannot be reestablished.

(326009)
• SYSOUT SSTM data sets were being incorrectly marked as using an In-Memory record-locking strategy

when hosted within MFDBFH, which returned a 9/100 status due to multiple processes attempting to
write display statements to the data set. In this scenario, SYSOUT SSTM data sets now use the default
Table record-locking strategy.

(299014)
• MFDBFH has been updated to be sensitive to the FAN settings on an Oracle Database, and is now

immediately notified when the database attempts to drain connections. In this case, MFDBFH attempts
to establish a new connection.

(375030)
• When registering an XA connection with MFDBFH, the registration process attempted to connect to

each entry in the MFDBFH.cfg file to determine if it matched the details of the XA resource. Underlying
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improvements have been made to reduce the number of connections made when the MFDBFH.cfg file
contains duplicate entries.

02459182 (390041)
• If the connection to an Oracle RAC environment was lost at a specific time, a COBRT114 error was

sometimes thrown in the XA Switch module. Additional checks have been added to the code to ensure
that this is no longer the case.

02366126 (350015)
• When using an Oracle database, if the connection was lost, the process failed to reconnect once the

connection to the database was reestablished. This has now been resolved.

02410660 (363051)
• Oracle queries that issued searches against large files used a full-table scan, slowing performance.

Performance has been improved by instructing the Oracle optimizer do a range scan instead of a full-
table scan in this case.

02516560 (406164)
• Additional diagnostics information has been added to assist in determining the cause of an RC 3 on

MFDBFH recovery processing.

02344102 (299021)
• A WRITE operation that used ADVANCING mnemonic-name sometimes threw an error. Support has

now been added to handle WRITE operations with mnemonic usage.

02209654 (246009)
• When a database ran out of available connections, stored procedures and functions were sometimes

lost. This release contains updates that reduce this risk.

02155281 (203093)
• A progress bar has been added to dbfhdeploy operations.

(381028)
• A new environment variable, MFDBFH_GRANT_USER_PERMISSIONS, has been added for Oracle

databases only to allow MFDBFH to grant execute privileges on types/procedures to specific users/
roles. This provides easier user privilege restriction on Oracle and creates a more secure environment
without having to manually modify the MFDBFH scripts. 

02459320 (389032), 02441860 (384006)
• Additional checks have been added to verify the integrity of the region/cross-region database tables

before running dbfhadmin -casprocess -recovery. If required, you are prompted to run
dbfhadmin -verify to fix the table integrity before recovery can continue.

02326339 (297036)

Micro Focus Common Client

Back to the list

• Programs using the Micro Focus Common Client (MFCC) component, such as COBOL applications
invoking a Web Service proxy created by the Interface Mapping Toolkit (IMTK), can now be built as
single-threaded applications on Linux and UNIX. They no longer need to be executed under the multi-
threaded COBOL runtime. Note: Multi-threaded applications are still supported.

(306131)
• The Micro Focus Common Client now adds Accept and Origin headers with default values to HTTP

requests if the invoking program has not set its own values for those headers. This improves
interoperability with some Web services.

Note: This affects COBOL Web service client proxy programs.

(104096)
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Micro Focus Cryptographic Library

Back to the list

• The version of OpenSSL provided with the product has been updated to 1.1.1t.

(407184)

Micro Focus Directory Server

Back to the list

• MFDS stopped when supplied with the incorrect mfServer property when updating an enterprise server
region. This has been fixed.

02547102 (442003)
• The casstart /s option incorrectly copied the start-type parameter. This has been fixed

02250159 (244185)
• An issue that sometimes caused MFDS to crash when starting multiple enterprise server regions

simultaneously has been fixed.

02310876 02409262 (286081)
• Micro Focus Directory Server internal session identifiers have been increased in size and complexity to

reduce vulnerability to attack.

02365249 (344004)
• Starting or stopping an enterprise server region using ESCWA or the MFDS UI intermittently terminated

the process. This has been fixed.

(415049)
• Modifying or deleting an enterprise server region's MFRHBINP Request Handler via the ESCWA user

interface or API is no longer allowed.

02525461 (413117)
• The Validate feature on an enterprise server region running on a UNIX platform sometimes incorrectly

flagged a valid Web Services and J2EE listener as not startable.

02370910 (318020)
• Enterprise server region start-up performance was slow when a large number of regions were specified

on a Micro Focus Directory Server with a large number of values stored in the vault facility. This has
been corrected.

(394122)
• If the MFDS process could not access the TCP port it was configured to use, it failed to start and

emitted the error message HS0001S HTTP server failed to initialize, rc=6:
CCITCP-0006E An invalid server or machine name was presented to CCITCP. It now
fails with the message HS0001S HTTP server failed to initialize, rc=57:
CCITCP-0057E Insufficient permission to complete an operation.

(388038)
• If the MFDS process could not access the TCP port it was configured to use, it failed to start and

emitted the error message HS0001S HTTP server failed to initialize, rc=6:
CCITCP-0006E An invalid server or machine name was presented to CCITCP. It now
fails with the message HS0001S HTTP server failed to initialize, rc=57:
CCITCP-0057E Insufficient permission to complete an operation

02433110 (380037)
• Some audit events output when setting the Create Audit Events option for the MFDS process using the

MFDS Web interface were not being output when using ESCWA to change the same configuration. This
has been corrected.

02412285 (365078)
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• MF Directory Server Enterprise Server Administration HTML Web interface was accepting UNC paths
as input values for some import and export operations. This has been fixed.

02423785 (369017)

Micro Focus License Administration

Back to the list

• Micro Focus License Administration now displays the licenses for the same product and serial number
but with a different expiry date on separate lines.

(365148)
• Some libraries have been updated to fix current known vulnerabilities.

(295042) (295068) (309006)
• The SafeNet server list can now be used as expected.

02341760 (259135)

Run-time System

Back to the list

• The memory associated with a dynamic length item declared in local-storage was not released when
the program instance exited, which led to memory leakage. This has been fixed.

(443004)
• The Run-time System now produces an RTS error if the Profiler attempts to output an .ipf file in a

read-only directory.

(407092)
• An issue in the native Run-Time System's clean-up logic sometimes resulted in a crash when a .NET

AppDomain running a .NET COBOL program was unloaded. This has now been fixed.

02259505 (301047)
• Previously, in some ES region configurations, enabling CTF tracing for RTS API events could result in

very large CTF trace log files, and cause an ES region to take a very long time to start. This has now
been fixed.

02320601 02497148 (403104)
• If a debugger process was killed on Linux (using kill -9 <pid>) then the debugger process could hang in

certain circumstances. This has now been resolved.

(387100)
• If multiple asynchronous run-units are created, with CBL_EXEC_RUN_UNIT on UNIX/Linux, then it was

possible for some of them to be left marked as "<defunct>" in the OS process table. This has now been
resolved.

02537643 (422001)
• The CBL_CULL_RUN_UNITS API now more closely complies with the documented behavior on UNIX.

It now clears all asynchronous run-units, when multiple run-units have terminated, and does not clear
child processes that are not run-units.

(439075)
• The event priority of a CTF API entry is set to a default value of 0 when CBL_EXIT_PROC is called with

a function code that does not expect a priority or provides an invalid one.

(380019)
• Using a DISPLAY statement from a SQL CLR stored procedure sometimes resulted in a

System.NullReferenceException. This is now fixed.

02533532 (415173)
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• Publishing a program with an XML GENERATE statement in an SQL stored procedure now works as
expected once the project files are manually edited appropriately.

02508845 (407057)

Setup Issues (UNIX)

Back to the list

• The RPM installer for Enterprise Developer for Eclipse was missing some of the required components.
This has been corrected.

02366247 (306126)
• You can use the environment variable TMPDIR when installing the product. See Visual COBOL

Development Hub Installation Options in your product Help for more information.

(252002)

SQL: COBSQL

Back to the list

• A problem with COBSQL that prevented it from handling the FETCH conversion of more than 100K
rows has been fixed.

02236464 (260248)
• COBSQL has ben updated to handle ENTRY statements broken into multiple lines.

02417156 (367003)
• COBSQL has been modified to handle inline comments in EXEC SQL statements when using the

SYBASE precompiler.

(285007)
• COBSQL has been updated for SYBASE such that it no longer inserts a period when an EXEC SQL

statement is coded inside of an IF block. 

01886033 (125015)
• COBSQL has ben updated to handle inline comments inside DECLARE blocks when Informix is used.

02380790 (348020)
•  The COBSQL preprocessor has been updated to support the ALPHA-LIT-CONT directive.

02544092 (430025)

SQL: DB2 ECM

Back to the list

• The DB2 ECM now correctly sets the length of the PIC G host variables before CHARSET conversion.

(424053)

SQL: OpenESQL

Back to the list

• A problem that caused erroneous memory usage in the OpenESQL run time has been fixed.

02321779 (293023)
• A problem that prevented parameters in the ADO UNBIND CONNECTION statement from being

replaced has been fixed.

(406004)
• A problem that prevented a temporary table from being created has been fixed.
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02494026 (401152)
• A problem that prevented PostgreSQL from applying the expected values when set statements

contained three or more host variables has been fixed.

02506484 (405077)
• The .NET 6 ODBC Nuget package was missing some dependencies. These are now included.

02474422 (395110)
• The column length of a VARCHAR type column was returned incorrectly when the SQL statement was

being prepared dynamically. This has been corrected.

02503856 (405091)
• A problem that prevented database locks from being released at the end of an DSNALI transaction

when using switch modules that use OpenESQL has been fixed.

02307521 (296031)
• A problem that occurred when specifying the SQL(CLOSE_ON_ROLLBACK=NO) directive caused SQL

Server to automatically close a cursor after a rollback statement has been corrected.  The cursor is now
defined as a fast-forward cursor instead of a fire-hose cursor.

(401104)
• A problem with the ODBC ECM that produced a subscript-out-of-range error when using a host variable

with a leading FILLER item before a data item in an SQL statement has been fixed.

02334866 (312064)
• A problem that sometimes occurred when compiling DBCS code in SJIS locale for embedded SQL

applications has been fixed.

02349559 (301080)

XML Support

Back to the list

• The XML runtime now performs better when reading a large XML file.

02526445 (417029)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Defect number (in parentheses).

• (295041)
• 02508043 (407049)
• 02479358 (393153)
• 02504425 (424001)
• 01901711 (127012)
• 02287394 (258209)
• 02558536 (447020)
• 02190101 (363024)
• (381007)
• (384016)
• 02450685 (386098)
• 02423113 (364179)
• 02439474 (382038)
• 02453576 (385060)
• 00373758 (448044)
• 02500115 (406011)
• (402012)
• 02458038 (387132)
• 02544746 (425075)
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Unsupported or Deprecated Functionality
This section includes information about features or functionality that are not supported.

• The SafeNet Sentinel licensing system has been deprecated and will be not available in this product
starting with the next major release - release 10.0. The SafeNet Sentinel licenses will not be supported
after release 9.0. You can only use AutoPass licenses starting with release 10.0.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
However, it is not necessary to switch to AutoPass licenses unless you are adopting release 10.0.
Contact Micro Focus Customer Care for further information.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Additional Software Requirements
To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software.

Click here to see this information on the Product Documentation pages on Micro Focus Customer Care, in
the product Help for Visual COBOL for Eclipse (Windows).

Click here to see this information on the Product Documentation pages on Micro Focus Customer Care, in
the product Help for Visual COBOL for Eclipse (UNIX).

Click here to see this information on the Product Documentation pages on Micro Focus Customer Care, in
the product Help for Visual COBOL Development Hub.
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Installation

Installing Visual COBOL for Eclipse

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

On Windows

System Requirements for Visual COBOL for Eclipse (Windows)

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are, approximately:

Visual COBOL

2.6GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Visual COBOL setup file. This includes the space needed to
cache information locally so that you can modify the installation without the original source media.

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

Also note the following:

• A 64-bit Windows is required. 32-bit Windows is not supported. See Installation in Known Issues and
Restrictions.

You can produce both 64-bit and 32-bit applications with Visual COBOL on 64-bit operating systems.

• The Server Core form of Windows Server 2019 is not supported.
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Software requirements

Note: This product includes OpenSSL version 3.0.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Requirements for the setup file

• A 64-bit Windows is required. 32-bit Windows is not supported. See Installation in Known Issues and
Restrictions.

• The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.24 (2022-06).

Visual COBOL only supports the 64-bit version of Eclipse. You can use the 64-bit Eclipse to create both
32-bit and 64-bit applications.

• The setup file installs Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot.
• The setup file also installs Microsoft's Visual C++ 2012 and 2015-2022 Redistributables.

Requirements for running the product

• Java 11 (64-bit) or later is required to run the Eclipse IDE. The recommended version is Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Windows, the installer automatically installs Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Linux, you need to install Java before you install this
product. You can download Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot from Adoptium's Web
site and unpack the archive anywhere on your machine.

• Visual COBOL requires a 64-bit Java installation to run a 64-bit Eclipse.
• Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL

development environment depend on certain files that Microsoft distributes in the following package: the
Windows SDK package. See Microsoft Package Dependencies for a full list of actions and operations
that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cblmx`s command line utility post-installation to manage this; see Managing the Microsoft
Build Tools and Windows SDK Packages for more information.

See Java Support Restrictions in the product help for any considerations when using Eclipse and Java.

License Manager requirements

• The Micro Focus License Administration tool requires Java to run. It supports Java 1.7 or later.
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Visual COBOL client and a new licensing server on the same machine.
• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.
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Product Co-Existence

Note: The following applies to Windows only.

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements

Before starting the installation you should consider the following:

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Various actions and operations within your COBOL development environment depend on certain
Microsoft files distributed in the following packages: the Windows SDK package and the Microsoft Build
Tools package. By default, a standard product installation downloads and installs these. Refer to
Microsoft Package Dependencies to see if these packages are required. If you do not plan to use your
development tool in a way that will depend on any of these packages, you can run a non-standard
installation, which will skip their download and installation, thus saving disk space and time taken for
installation. Refer to Advanced Installation Tasks for details on the available installation options.

On UNIX

System Requirements for Visual COBOL for Eclipse (UNIX)

Hardware Requirements for Visual COBOL for Eclipse

Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x86-64
running Red
Hat Linux

Micro Focus 1.49 GB 5.96 GB 2.98 GB 50 MB

x86-64
running SUSE
SLES

Micro Focus 1.25 GB 5 GB 2.5 GB 50 MB

System Z
running SUSE
SLES

Micro Focus 856 MB 3.42 GB 1.71 GB 50 MB

x64 running
Amazon Linux
2

Micro Focus 1.21 GB 4.84 GB 2.42 GB 50 MB

x64 running
Ubuntu

Micro Focus 1.22 GB 4.88 GB 2.44 GB 50 MB
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x86-64
running Rocky
Linux

Micro Focus 1.49 GB 5.96 GB 2.98 GB 50 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.

Software Requirements

The setup file requires that the following software and libraries are installed before you start the installation,
and that certain environment variables are set.

• Software required by the setup file
• Libraries required by the setup file
• Required environment variables
• Software installed by the setup file
• Requirements for running the product
• License Manager requirements

Software required by the setup file

The following software must be installed in advance:

• Java versions 11 or later from Adoptium (such as the Adoptium OpenJDK Temurin 17 (LTS) with
HotSpot) and Oracle are required for Visual COBOL for Eclipse.

• The unzip utility.
• The "awk", "ed", "ps", "sed", tar", "sed", and "which" utilities must be installed and added to the PATH.
• If SELinux is installed and you plan to use anything other than core COBOL functionality, or plan to use

Enterprise Server within an environment with ASLR enabled, the "SELINUX" configuration must be
disabled. To do this, set SELINUX=disabled in /etc/selinux/config.

Libraries required by the setup file

The 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating Systems for this
product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

Library Bitism Platform

32-
bit

64-
bit

SUSE 121 SUSE 151 Red Hat 7 Red Hat 8 Ubuntu
20.4

Amazon
Linux 2

glibc2 X X X X X

libgcc X X X X X

libgc1c2 X X
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Library Bitism Platform

32-
bit

64-
bit

SUSE 121 SUSE 151 Red Hat 7 Red Hat 8 Ubuntu
20.4

Amazon
Linux 2

libstdc++ X X X X X

glibc-locale3 X X X X

libXtst6 X X X X

libXtst X X X X

glibc-devel X X X

gtk3 X X7 X7 X7

PackageKit-
gtk3

X X7 X7 X7

libcanberra-
gtk3

X X7 X7 X7

webkitgtk3 X X7 X7

webkit2gtk3 X X7

xterm Any
versi
on

Any
versi
on

X X X X X X

unzip Any
versi
on

Any
versi
on

X X X X

libgnome X X

libgtk-3-0 X X7 X7 X

gtk3-tools X X7 X7

gcc45 X X X X X X X

cpp4 X X X X

libnotify-tools6 X X X X

libnotify X X

libjasper1 X X X

libjasper4 X X

Note:

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• 1On SUSE 12 or 15, you can only install the 64-bit version of Visual COBOL. The glibc-locale-32bit

library is still required by the SafeNet licensing components.
• * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the

GNU Project Debugger) can be installed from the install media for your OS.
• 2The glibc-locale-32bit library is only required if you want to install the SafeNet licensing

components. If this is present, the installer installs and configures both SafeNet and AutoPass
licensing. If glibc-locale-32bit is not installed, the installer only installs AutoPass licensing.

• 3On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
• 4On Red Hat, these libraries are required to enable COBOL to compile.
• 5On Red Hat, only the 64-bit gcc libraries are required.
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• 6For SUSE 12 and later, you might need to install the Notifications Library tools (libnotify-tools).
This is to enable notifications to be displayed by the notify-send tool when starting Visual COBOL
for Eclipse from a desktop icon. Execute the following command to install the libnotify-tools library:

zypper install libnotify-tools

• 7The minimum GTK support required is 3.22. Certain platforms meet this requirement without the
need of installing the libraries manually; for example Red Hat 7.4 and SUSE 12 SP3.

Required environment variables

Before you start the installation, you need to set the environment as follows:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the installer.

The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

Software installed by the setup file

• The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.24 (2022-06). After the
installation, you can install Visual COBOL as a plug-in into other Eclipse 4.24 (2022-06) instances
available on the same machine - see Installing Visual COBOL into other instances of Eclipse.

Note: On SUSE platforms, you can only use the 64-bit version of Eclipse to produce 64-bit
applications; on other 64-bit platforms, you can use Eclipse to produce both 32-bit and 64-bit
applications.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
always installed by default. Use your UNIX/Linux installation media to install it.

Requirements for running the product

• Java 11 (64-bit) or later is required to run the Eclipse IDE. The recommended version is Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Windows, the installer automatically installs Adoptium's
OpenJDK Temurin 17 (LTS) with HotSpot. On Linux, you need to install Java before you install this
product. You can download Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot from Adoptium's Web
site and unpack the archive anywhere on your machine.

License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Visual COBOL client and a new licensing server on the same machine.
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• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Installation on UNIX and Linux (Known Issues)

• If you reinstall Visual COBOL for Eclipse on a UNIX machine, it is possible that Eclipse will start without
loading the Micro Focus features. To solve this, you must delete the .eclipse folder in your home
directory and restart Visual COBOL.

Installing on Linux

On Linux, the RPM installer for Visual COBOL for Eclipse installs a 64-bit version of Java. When you start
the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevents
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:

• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For example,

untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Visual COBOL.

Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:

error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No 
such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed

As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.
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The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks in your product Help.

On Windows

Installing on Windows

Note:

• This version of the product is a full install.
• If you have an earlier version of Visual COBOL installed on your machine, check Installing as an

Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Visual COBOL:

1. Run the vce_90.exe file and follow the wizard instructions to complete the installation.

By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL folder and installs a full version of Eclipse 4.24 (2022-06) 64-bit, with the Micro Focus plugins
already installed, in the C:\Users\Public\Micro Focus\Product Name\eclipse directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks.

On UNIX

Installing the software

Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for
installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux.
See your product Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_deveclipse_9.0_platform

2. Run the setup file with superuser permissions:

./setup_visualcobol_deveclipse_9.0_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR). A
full version of Eclipse, with the Micro Focus plugins already installed, is present in the $COBDIR/
eclipse directory.
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To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_deveclipse_9.0_platform -installlocation="full path of 
new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Note: See Installing in an Ubuntu Docker Image Running on Windows 11 for specific installation
instructions for this scenario.

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

. /setup_visualcobol_deveclipse_9.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:

./setup file -skipautopass

• To protect the AutoPass installation from accidental updating, you can create an empty file named
SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:

touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

Setting up the environment

If you have installed the product to a directory other than the default one, you need to set the environment
as described below.
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Note: The default directory is /opt/microfocus/VisualCOBOL.

1. To set up your product, execute:

. <product-install-dir>/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Starting the product

To start Eclipse:

• If you are using a GUI interface, double-click the product icon (automatically installed on your desktop).

Note: The installer automatically creates a shortcut icon for the product on the desktop for the user
for which you ran the install script. If you need to create desktop icons for other users' desktops on
the same machine, or if the icon was not created on the desktop for the root user, run the following
shell script as the user you need to login as: $COBDIR/bin/createdesktopicon.sh

• If you are using a non-GUI interface, such as a terminal emulator, type the following from a command
prompt:

eclipse

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
• Installing into other instances of Eclipse - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care

See this information on the Product Documentation pages on Micro Focus Customer Care - for Visual
COBOL for Eclipse for Windows click here and for Visual COBOL for Eclipse for UNIX click here.

Click here to see this information on the Product Documentation pages on Micro Focus Customer Care for
Visual COBOL Development Hub.

On Windows

Installing as an Upgrade

• This release cannot be installed as an upgrade to an earlier release of Visual COBOL. You must
uninstall the previous version before installing 9.0.
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Visual COBOL Installation Options

To see what parameters you can use, execute the following from the command line:

install-file /help

where install-file for the following products is as follows:

Visual COBOL vce_90.exe

See the Examples section further in this topic for examples of some of the parameters you can use.

Directory considerations

• You must have read and write access for every directory accessed during the installation.
• You can override the default installation folder using the InstallFolder parameter.

• Installing creates a group of log files prefixed Micro_Focus_ in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the
path and file name, for example:

/log drive:\path\LogFilename

Skipping installation of the Microsoft package dependencies

A standard installation downloads and installs the latest versions of the Microsoft Build Tools (for Visual
Studio 2017) and the Windows 10 SDK packages to their default locations. Using the following option, you
can skip installation of these packages, thus reducing the footprint and duration of the installation. See
Microsoft Package Dependencies to see if you can safely skip installing these packages.

vce_90.exe skipmstools=1 

Offline installations

An offline installation is one where the client running an install is not connected to the internet; the problem
this presents is that the installer cannot download and install certain file and package dependencies; see
Microsoft Package Dependencies. In such circumstances, an administrator (or at least someone connected
to the internet) must download and make any dependencies available on the local network beforehand.

To prepare an offline installation, the administrator should run their own (online) installation using the
downloadmstools parameter: this downloads the package dependencies to <directory>, which should
be a fully-qualified path to a location accessible to the client when they run an installation.

start /wait vce_90.exe /q downloadmstools=<directory>

A client can then run an offline installation by pointing their installer at the location of the packages:

vce_90.exe installmstools=<directory>

This command runs a full product install; during which it uses the locally-accessible <directory> to install
the package dependencies.

Installing silently
You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (installfolder=path), user information, and which
features to install. You must execute the command with superuser permissions.

start /wait install-file.exe /q [parameters]

Examples

• To silently install Visual COBOL into a directory other than the default:

start /wait vce_90.exe /q InstallFolder=c:\DirectoryName
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• If you want to silently install the Eclipse IDE in a location other than the default, execute:

start /wait vce_90.exe /q InstallFolder2=c:\EclipseInstallDirectory

Microsoft Package Dependencies

Various actions and operations within your COBOL development environment depend on certain files that
Microsoft distributes in the following package: the Windows SDK package.

There is a dependency on the Microsoft Windows SDK if you:

• Produce COBOL .exe or .dll files.
• Call Windows APIs from your COBOL .exe or .dll files.
• Link a C object file into a COBOL .exe or .dll file.
• Call Windows APIs from a C object file linked into a COBOL .exe or .dll file.
• Create MIDL files for OLE RPC.

There is a dependency on the Microsoft Build Tools if you:

• Produce COBOL .exe or .dll files.
• Manage .lib files.
• Convert resource files to object modules.

If you distribute a COBOL product installation to clients that do not have access to the internet, then you
need to have downloaded these packages and placed them in an accessible place on the network before
clients can run an 'offline installation'. The installer includes options to achieve this: downloadmstools
enables you to download the required packages to a specific location; and installmstools enables an
offline client to install the packages from a local network location.

If you do not use any of the features described above, you can use an install parameter (skipmstools=1)
that will skip the download and installation of these dependencies.

All of these installation options are discussed in more detail in the Installation Options topic for your
product.

One of the final steps of the installation process configures the downloaded and installed package versions
for use in your COBOL environment. You can view these versions using the Windows SDK Configuration
Utility - see Managing the Microsoft Build Tools and Windows SDK Packages. This utility also enables you
to specify alternative versions should you need to depend on a specific package other than the one
downloaded, or one stored in a non-default location.

On UNIX

Installing as an upgrade

This release works concurrently with the previous version of Visual COBOL, so you do not need to uninstall
it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Visual COBOL installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL_eclipse"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv
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Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Preserving Product Configuration

The following information applies when you are upgrading from releases 6.0, 7.0, or 8.0.

If you install this release to the same install location as release 6.0, 7.0, or 8.0, the product in the current
location is moved to a backup directory name.

For example, if the 7.0 product is installed in the default install location, /opt/microfocus/
VisualCOBOL, during the installation process it is moved to /opt/microfocus/
VisualCOBOL.BKP.YYYY-MM-DD.HH:MM:SS. The new release will be installed in /opt/microfocus/
VisualCOBOL. The backup location will store your original installation along with any files you deployed to
that directory. It will also contain any configuration files you modified post-install.

When installing 9.0 the installer moves a number of specific configuration files to a different configuration
location and symbolically links them back to the new release install location. The configuration location will
be one of the following:

• The default config location is /opt/microfocus/config/.
• For non-root installation, the default location is $HOME/microfocus/config/.
• To specify your own configuration location, run the setup file with the following command-line option: -

mfconfiglocation=[location]

The setup file creates a directory in the configuration location using a 5-digit checksum of the $COBDIR
path. This is so that each configuration location is unique to each product installation. The configuration
files and directories are then placed in this COBDIR checksum directory. In the following example, the
install location generates a checksum of 39082.

The file /opt/microfocus/config/39082/COBDIRlocation.txt details the COBDIR the
configuration area is associated with.

If you have changed any other files in the original installation, you need to be copy these manually from the
backup directory, /opt/microfocus/VisualCOBOL.BKP.YYYY-MM-DD.HH:MM:SS, into the install
location after the upgrade installation is complete.

You can access the configuration area from $COBDIR/etc/config.

Currently, the setup file only moves the following files and directories, where applicable:

Source Destination

$COBDIR/etc/mfds /opt/microfocus/config/39082/mfds/mfds

$COBDIR/etc/ccsid /opt/microfocus/config/39082/config/
ccsid

$COBDIR/etc/secrets /opt/microfocus/config/39082/secrets

$COBDIR/bin/mf370ctl.cfg /opt/microfocus/config/39082/config/
mf370ctl.cfg

$COBDIR/bin/CCI.INI /opt/microfocus/config/39082/config/
CCI.INI

$COBDIR/deploy/.mfdeploy /opt/microfocus/config/39082/
deploy/.mfdeploy

$COBDIR/etc/cas/CTFesjcl.cfg /opt/microfocus/config/39082/cas/
CTFesjcl.cfg
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Source Destination

$COBDIR/etc/cas/dfhdrdat /opt/microfocus/config/39082/cas/
dfhdrdat

$COBDIR/etc/commonwebadmin.json /opt/microfocus/config/39082/escwa/
commonwebadmin.json

$COBDIR/etc/mfdsacfg.xml /opt/microfocus/config/39082/mfds/
mfdsacfg.xml

$COBDIR/etc/mfdsacfg.dat /opt/microfocus/config/39082/mfds/
mfdsacfg.dat

$COBDIR/etc/mf-client.dat /opt/microfocus/config/39082/mfds/mf-
client.dat

$COBDIR/etc/mf-server.dat /opt/microfocus/config/39082/mfds/mf-
server.dat

$COBDIR/etc/cobol.dir /opt/microfocus/config/39082/config/
cobol.dir

$COBDIR/etc/cobopt /opt/microfocus/config/39082/config/
cobopt

$COBDIR/etc/cobopt64 /opt/microfocus/config/39082/config/
cobopt64

$COBDIR/etc/cobjvm.cfg /opt/microfocus/config/39082/config/
cobjvm.cfg

$COBDIR/etc/cobutf8.cfg /opt/microfocus/config/39082/config/
cobutf8.cfg

$COBDIR/etc/default.tcf /opt/microfocus/config/39082/config/
default.tcf

$COBDIR/etc/mfescache.cfg /opt/microfocus/config/39082/config/
mfescache.cfg

$COBDIR/etc/dsdef.cfg /opt/microfocus/config/39082/config/
dsdef.cfg

Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_deveclipse_9.0_platform -installlocation="full path of 
new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Installation | 61



Skip Java Check

To skip the Java version check, use the -skipjavachk option. This skips the parts of the installation that
require Java, for example, the Eclipse installation. This can be used when you do not have Java on your
path and want to perform a custom installation. You can then manually configure the plug-ins as required:

./setup_visualcobol_deveclipse_9.0_platform -skipjavachk

Skip Installing Eclipse

To skip the installation of Eclipse, use the -skipeclipse option. This enables you to install Visual
COBOL into your own version of Eclipse.

./setup_visualcobol_deveclipse_9.0_platform -skipeclipse

Note: You need to install the COBOL plug-ins manually.

Installing into a 32-bit Version of Eclipse

To skip the installation of the shipped Eclipse version but still install the plug-ins, use the -32bit option.
This enables you to install your own 32-bit version of Eclipse and manually install the required Visual
COBOL components.

./setup_visualcobol_deveclipse_9.0_platform -32bit

Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus Customer Support Documentation Web

site for any documentation updates.
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On Windows

Configuring Visual COBOL

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Managing the Microsoft Build Tools and Windows SDK Packages

There are a number of COBOL development features that depend on the Microsoft Build Tools and
Windows SDK packages. By default, the product installer downloads and installs these packages to their
default locations. The installer then sets your COBOL environment to depend on those downloaded
versions.

You can use the Microsoft Build Tools and Windows SDK Packages configuration utility - cblms - to view
which versions are in use, and also configure your COBOL environment if you require something other
than the standard usage.

There is an option within the product installer to skip the installation of the default packages
(skipmstools=1); however, this does skip both packages, so make sure that you do already have the
package(s) that you require before setting this - see Microsoft Package Dependencies for details on the
package(s) you may require.

The Microsoft Build Tools and Windows SDK Configuration Utility

Use the cblms command line utility to view and set the package versions in effect for your COBOL environment.

Important: If you are updating or clearing package versions, you must run this utility from a command
prompt with administrative privileges.

Syntax:
cblms <option>

Parameters:

Note: <option> settings are case insensitive.

<option> can be one of:

-U
Updates the COBOL environment to use the latest versions of the Microsoft Build Tools
and SDK packages that are located in the default folders. Any open IDE instance or
command prompt must be restarted before these changes take effect.

-U<ms-pkg>
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Updates the COBOL environment to use the latest version of the particular package type
that is located in the default folder. Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the default folder.Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<path>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-U<ms-pkg>:<path>?<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-L
Lists all versions of the Microsoft Build Tools and SDK packages that are located in the
default folders.

-L<ms-pkg>
Lists all versions of a particular package type that are located in the default folder.

-L<ms-pkg>:<path>
Lists all versions of a particular package type that are located in the (non-default) folder
specified.

-Q
Displays the versions currently in use by the COBOL environment.

-Q<ms-pkg>
Displays the version of the selected package type that is currently in use by the COBOL
environment.

-R
Clears all version information. (Only use this option when instructed to by Customer Care.)

-H
Displays the available command line options.

Legend:

<ms-pkg> <ms-pkg> can be one of S or SDK for the Microsoft SDK, or B or BT for the Microsoft Build
Tools.

<path> <path> is the path in which to locate packages that are not installed to the default location for
their package type.

<version> <version> is the package version with which to update when the latest version is not the one
required. When specifying version, it must be in the form:

• n.n.n.n for a Windows SDK
• n.n.n for Build Tools
• n for list ID - the list ID is displayed using cblms -L.
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The following example updates the COBOL environment to use version 10.0.17134.0 of
the Windows 10 SDK, installed in C:\WinSDK\10.

cblms -USDK:C:\WinSDK\10\10.0.17134.0

Using an X Server on Windows

Some features of Visual COBOL for Eclipse on Windows require an X Server installation such as Micro
Focus OpenText™ Reflection Desktop for X or Micro Focus ViewNow X.

Micro Focus Reflection Desktop for X is provided as part of Visual COBOL. Find the Reflection Desktop for
X documentation on the Micro Focus Customer Care dropdown menu.

Viewing the Product Help

Visual COBOL is configured to display the product help available online on the Micro Focus Customer Care
website: https://www.microfocus.com/en-us/support/documentation/.

You can view the Visual COBOL product help in one of the following ways:

Choose whether to view the help online or locally

You can configure Eclipse to show the Visual COBOL help either online or locally:

1. In Eclipse, click Window > Preferences > Micro Focus > Help.
2. Either disable or enable Use online documentation, depending on whether you want to see the

documentation locally or online.

Online help (default)

• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Visual COBOL help.

Note: Ensure that you have an up-to-date version of your browser.

Local help

1. Configure Eclipse to use local help as detailed above.
2. Access the local help in one of the following ways:

• Click Help > Help Contents to open the Help Viewer, then open the Micro FocusMicro Focus-
branded documentation.

• Alternatively, press F1 inside the editor or after clicking a dialog within the UI.

Repairing on Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

Important: Before performing a repair of the installation, Micro Focus recommends that you create
backups of any configuration files of the product that you might have changed.

To repair your installation:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.
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Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.

Important: The installer creates separate installations for Micro Focus Visual COBOL Micro Focus
Analysis Services Integration, and Micro Focus License Administration. Uninstalling only Visual
COBOL does not automatically uninstall the Micro Focus License Administration or any of the
prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

On UNIX

Configuring Visual COBOL

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Configuring the Environment for Developing RDBMS Applications on UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.
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1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Enabling SHIFT-JIS

By default, support for the character encoding for the Japanese language, Shift-JIS, is not available on
Ubuntu and on RedHat OS version 8 or later.

You need to generate the Shift JIS locale on your machine to be able to execute Shift-JIS applications on
these platforms. You can do this as follows:

1. On RedHat 8, ensure that the glibc-locale-source package is installed.
2. Execute the following command with superuser rights in order to generate a Shift-JIS locale using the

charset:

sudo localedef -f SHIFT_JIS -i ja_JP ja_JP.sjis

3. Set the COBUTF8 environment variable to the generated Shift-SJIS locale and LANG to a UTF8 locale:

export COBUTF8=ja_JP.sjis
export LANG=ja_JP.UTF-8

4. Run the cobutf8 utility:

cobutf8 <command>

See your product documentation for more details about cobutf8.

Viewing the Product Help

Visual COBOL is configured to display the product help available online on the Micro Focus Customer Care
website: https://www.microfocus.com/en-us/support/documentation/.

You can view the Visual COBOL product help in one of the following ways:

Choose whether to view the help online or locally

You can configure Eclipse to show the Visual COBOL help either online or locally:

1. In Eclipse, click Window > Preferences > Micro Focus > Help.
2. Either disable or enable Use online documentation, depending on whether you want to see the

documentation locally or online.

Online help (default)

• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Visual COBOL help.

Note: Ensure that you have an up-to-date version of your browser.
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Local help

1. Configure Eclipse to use local help as detailed above.
2. Access the local help in one of the following ways:

• Click Help > Help Contents to open the Help Viewer, then open the Micro FocusMicro Focus-
branded documentation.

• Alternatively, press F1 inside the editor or after clicking a dialog within the UI.

Repairing

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Before performing a repair of the installation, Micro Focus recommends that you create backups of any
configuration files of the product that you might have changed.

Uninstalling

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOLEclipse9.0.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing Visual COBOL Development Hub

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.
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Installation on UNIX and Linux (Known Issues)
• If you reinstall Visual COBOL for Eclipse on a UNIX machine, it is possible that Eclipse will start without

loading the Micro Focus features. To solve this, you must delete the .eclipse folder in your home
directory and restart Visual COBOL.

Installing on Linux

On Linux, the RPM installer for Visual COBOL for Eclipse installs a 64-bit version of Java. When you start
the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevents
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:

• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For example,

untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Visual COBOL.

Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:

error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No 
such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed

As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

System Requirements for Visual COBOL Development Hub

Hardware Requirements

The disk space requirements are approximately:
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x64 running
Amazon Linux
2

Micro Focus 588 MB 2.35 GB 1.18 GB 50 MB

Amazon for
Docker

Micro Focus 587 MB 2.35 GB 1.17 GB 50 MB

POWER
running AIX

Micro Focus 1.06 GB 4.06 GB 2.03 GB 41 MB

System Z
running Red
Hat Linux

Micro Focus 482 MB 1.93 GB 964 MB 39 MB

x86-64
running Red
Hat Linux

Micro Focus 865 MB 3.46 GB 1.73 GB 50 MB

64 running
Red Hat Linux

Micro Focus 502 MB 2 GB 1 GB 50 MB

Red Hat for
Docker

Micro Focus 592 MB 2.37 GB 1.18 GB 50 MB

SPARC
running
Solaris

Micro Focus 756 MB 3.02 GB 1.51 GB 42 MB

x86-64
running
Solaris

Micro Focus 724 MB 2.90 GB 1.45 GB 33 MB

System Z
running SUSE
SLES

Micro Focus 435 MB 1.74 GB 870 MB 39 MB

x64 running
SUSE SLES

Micro Focus 628 MB 2.5 GB 1.26 GB 50 MB

x64 running
Ubuntu

Micro Focus 597 MB 2.39 GB 1.19 GB 50 MB

SUSE for
Docker

Micro Focus 627 MB 2.51 GB 1.25 GB 50 MB

Ubuntu for
Docker

Micro Focus 627 MB 2.51 GB 1.25 GB 50 MB

x86-64
running Rocky
Linux

Micro Focus 865 MB 3.46 GB 1.73 GB 50 MB

Rocky Linux
for Docker

Micro Focus 592 MB 2.37 GB 1.18 GB 50 MB

x86-64
running
Oracle Linux -
Red Hat
Compatibility
Kernel

Micro Focus 865 MB 3.46 GB 1.73 GB 50 MB
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Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.

Software Requirements

Note: This product includes OpenSSL version 3.0.

The following topic lists the software requirements for Visual COBOL Development Hub.

• Software required by the setup file
• Libraries required by the setup file
• Software required to run the product
• Required environment variables
• License Manager requirements

Software required by the setup file

• The "awk", "ed", "ps", "sed", tar", "sed" and "which" "tar" utilities must be installed and added to the
PATH.

• If SELinux is installed and you plan to use anything other than core COBOL functionality, or plan to use
Enterprise Server within an environment with ASLR enabled, the "SELINUX" configuration must be
disabled. To do this, set SELINUX=disabled in /etc/selinux/config.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
always installed by default. Use your UNIX/Linux installation media to install it.

Libraries required by the setup file

The following table lists the required libraries for Red Hat and SUSE Linux platforms. The setup file checks
that both the 32-bit and 64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

The following table shows which of the required libraries are not installed by default on the specified platforms - X
indicates the libraries are missing.

Library Platform

32-
bit

64-bit s390 SUSE
12¹

SUSE 15 Red Hat
7

Red Hat 8 CentOS 7 Ubuntu 18
and 20

glibc2 X X X X X X

libgcc X X X X X X

libstdc++ X X X X X X

glibc-devel X X X X X

gcc3, 4 X X X X X X X X

cpp3 X X X X

libgc1c2 X X

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
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• ¹On SuSe 12 or 15, you can only install the 64-bit version of this product. The glibc-locale-32bit library is
still required by the SafeNet Sentinel licensed components.

• 2On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
• 3On Red Hat, these libraries are required to enable COBOL to compile.
• 4On Red Hat, only the 64-bit gcc libraries are required.

Visit the Red Hat Web site for more information.

Software required to run the product

• Java 1.8 (64-bit) or later is required to run Visual COBOL Development Hub. The recommended version
is Adoptium's OpenJDK Temurin 17 (LTS) with HotSpot. You can download Adoptium's OpenJDK
Temurin 17 (LTS) with HotSpot from Adoptium's Web site and unpack the archive anywhere on your
machine.

Required environment variables

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the installer.

The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Visual COBOL client and a new licensing server on the same machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
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6. Run the installer suitable for your Operating System to install License Manager on your machine.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks in your product Help.

Installing Visual COBOL Development Hub
Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for
installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux.
See your product Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_devhub_9.0_platform

2. Run the installer with superuser permissions:

./setup_visualcobol_devhub_9.0_platform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

Note: On Ubuntu, the prompt for superuser password is not available. On this platform you must
either log in as root or use the sudo command to get root permissions before you run the installer.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

Enterprise Server System Administrator Process

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server processes
except the one for the Micro Focus Directory Server (MFDS). The Directory Server process (Enterprise
Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the Process
User ID which can affects the file access and creation.

You must supply the user ID at the command line - specify -EsadminID=[ ID ] as part of your
command.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh and follow the
onscreen instructions.

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_visualcobol_devhub_9.0_platform -skipsafenet
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• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:

./setup file -skipautopass

• To protect the AutoPass installation from accidental updating, you can create an empty file named
SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:

touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus

Infocenter
• Installing into other instances of Eclipse - available in the product Help and in the Micro Focus

Infocenter
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus

Infocenter

See this information on the Product Documentation pages on Micro Focus Customer Care - for Visual
COBOL for Eclipse for Windows click here and for Visual COBOL for Eclipse for UNIX click here.

Click here to see this information on the Product Documentation pages on Micro Focus Customer Care for
Visual COBOL Development Hub.

Installing as an Upgrade
This release works concurrently with the previous version of Visual COBOL Development Hub, so you do
not need to uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Visual COBOL Development Hub installer with the –installlocation option:
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1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/VisualCOBOL"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Preserving Product Configuration

The following information applies when you are upgrading from releases 6.0, 7.0, or 8.0.

If you install this release to the same install location as release 6.0, 7.0, or 8.0, the product in the current
location is moved to a backup directory name.

For example, if the 7.0 product is installed in the default install location, /opt/microfocus/
VisualCOBOL, during the installation process it is moved to /opt/microfocus/
VisualCOBOL.BKP.YYYY-MM-DD.HH:MM:SS. The new release will be installed in /opt/microfocus/
VisualCOBOL. The backup location will store your original installation along with any files you deployed to
that directory. It will also contain any configuration files you modified post-install.

When installing 9.0 the installer moves a number of specific configuration files to a different configuration
location and symbolically links them back to the new release install location. The configuration location will
be one of the following:

• The default config location is /opt/microfocus/config/.
• For non-root installation, the default location is $HOME/microfocus/config/.
• To specify your own configuration location, run the setup file with the following command-line option: -

mfconfiglocation=[location]

The setup file creates a directory in the configuration location using a 5-digit checksum of the $COBDIR
path. This is so that each configuration location is unique to each product installation. The configuration
files and directories are then placed in this COBDIR checksum directory. In the following example, the
install location generates a checksum of 39082.

The file /opt/microfocus/config/39082/COBDIRlocation.txt details the COBDIR the
configuration area is associated with.

If you have changed any other files in the original installation, you need to be copy these manually from the
backup directory, /opt/microfocus/VisualCOBOL.BKP.YYYY-MM-DD.HH:MM:SS, into the install
location after the upgrade installation is complete.

You can access the configuration area from $COBDIR/etc/config.

Currently, the setup file only moves the following files and directories, where applicable:

Source Destination

$COBDIR/etc/mfds /opt/microfocus/config/39082/mfds/mfds

$COBDIR/etc/ccsid /opt/microfocus/config/39082/config/
ccsid

$COBDIR/etc/secrets /opt/microfocus/config/39082/secrets

Installation | 75



Source Destination

$COBDIR/bin/mf370ctl.cfg /opt/microfocus/config/39082/config/
mf370ctl.cfg

$COBDIR/bin/CCI.INI /opt/microfocus/config/39082/config/
CCI.INI

$COBDIR/deploy/.mfdeploy /opt/microfocus/config/39082/
deploy/.mfdeploy

$COBDIR/etc/cas/CTFesjcl.cfg /opt/microfocus/config/39082/cas/
CTFesjcl.cfg

$COBDIR/etc/cas/dfhdrdat /opt/microfocus/config/39082/cas/
dfhdrdat

$COBDIR/etc/commonwebadmin.json /opt/microfocus/config/39082/escwa/
commonwebadmin.json

$COBDIR/etc/mfdsacfg.xml /opt/microfocus/config/39082/mfds/
mfdsacfg.xml

$COBDIR/etc/mfdsacfg.dat /opt/microfocus/config/39082/mfds/
mfdsacfg.dat

$COBDIR/etc/mf-client.dat /opt/microfocus/config/39082/mfds/mf-
client.dat

$COBDIR/etc/mf-server.dat /opt/microfocus/config/39082/mfds/mf-
server.dat

$COBDIR/etc/cobol.dir /opt/microfocus/config/39082/config/
cobol.dir

$COBDIR/etc/cobopt /opt/microfocus/config/39082/config/
cobopt

$COBDIR/etc/cobopt64 /opt/microfocus/config/39082/config/
cobopt64

$COBDIR/etc/cobjvm.cfg /opt/microfocus/config/39082/config/
cobjvm.cfg

$COBDIR/etc/cobutf8.cfg /opt/microfocus/config/39082/config/
cobutf8.cfg

$COBDIR/etc/default.tcf /opt/microfocus/config/39082/config/
default.tcf

$COBDIR/etc/mfescache.cfg /opt/microfocus/config/39082/config/
mfescache.cfg

$COBDIR/etc/dsdef.cfg /opt/microfocus/config/39082/config/
dsdef.cfg
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Visual COBOL Development Hub Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_devhub_9.0_platform -installlocation="full path of new 
location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA

Installing using the TMPDIR environment variable

By default, the product installer uses /tmp for temporary files and log files during installation. If /tmp is not
available on your system you can set the environment variable TMPDIR to an alternative location:

TMPDIR=/home/user/tmp
Export TMPDIR

Then run the installation as normal.

Note:

The TMPDIR setting is lost when the installer is elevated to root user within the installer. This occurs
when you run the installer as a non-root user, and are prompted for the root password during the
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installation process. Micro Focus recommends that you log in as root, set TMPDIR and then run the
installer. If you use sudo to run the installer, then use the following command-line syntax:

sudo TMPDIR=$TMPDIR setup…

or:

sudo TMPDIR=/home/user/tmp setup…

After Installing
• The information about Visual COBOL Development Hub is part of the Visual COBOL for Eclipse product

Help. A standalone product Help for Visual COBOL Development Hub is also available from the Product
Documentation section of the Micro Focus Customer Support Documentation Web site.

• Check the Product Documentation section of the Micro Focus Customer Support Documentation Web
site for any documentation updates.

Setting up the product
If you have installed the product to a directory other than the default one, you need to set the environment
as described below.

Note: The default directory is /opt/microfocus/VisualCOBOL.

1. To set up your product, execute:

. <product-install-dir>/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Note: If there are two or more products installed on the machine or the products are installed in non-
default locations then the /opt/microfocus/logs/MicroFocusProductRegistry.dat data
file can be used to find the product locations.

The file contains the following entries:

[ Install Location ]#[ Date of Installation ]#[ Product Name ]

For example:

/home/user1/VisCobol30#2017-01-20#Micro Focus Visual COBOL Development Hub
3.0

/home/user1/CobolServer30#2017-01-20#Micro Focus COBOL Server 3.0

Configuring the Remote System Explorer Support
Note: The following only applies if you are using Visual COBOL Development Hub with Visual
COBOL for Eclipse.

The remote development support from the Eclipse IDE relies upon Visual COBOL Development Hub
running on the UNIX machine and handling all requests from the IDE for building and debugging programs.
Visual COBOL Development Hub provides a UNIX daemon, the Remote Development Option (RDO)
daemon, which initiates the RDO as Eclipse clients connect to it. Whichever environment is used to start
the RDO daemon will be inherited for all servers and hence all build and debug sessions.
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Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated on the Development Hub from one of the Eclipse clients, the
environment used will be inherited from whatever was used to start the daemon. A typical example of the
kind of environment that might need to be set up would include database locations and settings for SQL
access at build/run time.

Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• A version of Perl.
• A version of Java 8 or later.
• The as (assembler) and ld (linking) programs on the path, as specified by the PATH environment

variable.

The daemon can be run with or without parameters. If no parameters are specified, the process relies on
the default values in $COBDIR/remotedev/rdo.cfg.

Use the following syntax to start the daemon (with super-user authority) on the remote host:

$COBDIR/remotedev/startrdodaemon [<port> <low port>-<high port>] 

where:

• <port> is the port number that the daemon should use to listen for connections from Eclipse. If no value
is given, it will default to the value specified in $COBDIR/remotedev/rdo.cfg; the default value on
installation is 4075.

Example: To start the daemon listening on port 4999:

$COBDIR/remotedev/startrdodaemon 4999

This command will override the default port in rdo.cfg.
• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use

to communicate with Eclipse on the client machine. If no values are given, the range defaults to that
specified in $COBDIR/remotedev/rdo.cfg; the default range on installation is 10000-10003.

Example: To instruct the daemon (on port 4999) to instantiate servers using a range of ports
4090-4993:

$COBDIR/remotedev/startrdodaemon 4999 4090-4993

This command will also override the default ports in rdo.cfg.

If the server has an active firewall, it is important that these ports are open in the firewall settings. You can
use the configrdo utility to set the default ports in rdo.cfg to ones already open in the firewall. If you
are running on Red Hat 7.2 (or later) or CentOS 7.2 (or later), you can also use the utility to open the
required ports in the active firewall. See Configuring the firewall for more information.

Stopping the Daemon

To stop the daemon, type the following command with super-user authority:

$COBDIR/remotedev/stoprdodaemon <port>

Configuring the firewall
If the server on which Visual COBOL Development Hub is installed is running a firewall, you must ensure
that certain ports and services are allowed through so that Eclipse running on a client machine can
communicate with it.
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To ensure successful communication between the IDE and Visual COBOL Development Hub when a
firewall is active, use the configrdo utility after initial setup or if you experience problems establishing a
connection between the two.

Tip: If you run the client-side and/or server-side connection diagnosis tools, these include a number
of tests relating to firewall configuration, and can indicate any problems with the current firewall
settings.

Use configrdo to configure the following settings:

• Set the default RDO daemon and server ports used by Visual COBOL Development Hub.
• Open additional ports in the firewall.

This option is only available on the following platforms: Red Hat 7.2 and later, or CentOS 7.2 and later.
• Add the ssh and samba services to the firewall.

This option is only available on the following platforms: Red Hat 7.2 and later, or CentOS 7.2 and later.

These changes can be temporary (for the duration of the current firewall being active), or be made
permanent (so that they persist after a system reboot). If you are not running any of the supported
platforms listed above, use your operating system's firewall commands to perform the equivalent functions.

To configure the firewall settings

To be able to run this utility:

• You must have super-user authority (e.g. root user)
• $COBDIR must be set to the value of the product install folder for Visual COBOL Development Hub.

1. From a shell command, run the following:

$COBDIR/remotedev/configrdo

2. At the Daemon port prompt, enter the port number that the daemon should listen on, or press Enter to
accept the default. 

Note: The default settings for these port prompts are specified in the rdo.cfg configuration file.

The Server range is a range of port numbers that a required RDO server will be started on when the
daemon receives a request.

3. At the Server range low port prompt, enter the starting number of the server port range and
press Enter, or press Enter to accept the default.

4. At the Server range high port prompt, enter the ending number of the server port range and
press Enter, or press Enter to accept the default. 

The defaults are written to the rdo.cfg configuration file.

If you are running this utility on Red Hat 7.2 (or later) or CentOS 7.2 (or later), an additional prompt is
displayed; otherwise, the utility closes.

5. At the Do you want to configure the firewall prompt, press Y and then Enter to configure
further firewall settings, or press N and then Enter to close the utility. If you selected Y, the configured
firewall zones are listed.

6. To configure an existing zone, press the corresponding number and then Enter, or press Enter for the
default zone (as indicated at the end of the prompt). 

Note: At this point, you can also create a new zone: press N and then Enter, and then type the
new zone name and press Enter. The new zone is listed, and you can now select its
corresponding number to configure it.

The current firewall status is displayed, where it checks if the currently specified ports are open in the
firewall; if they are not, the utility adds them to the firewall settings.
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7. If you need to open more ports, press Y and then Enter, and then enter either a single port number, or
a range, and then press Enter. 

The additional ports are opened.

8. If either of the ssh and samba services are not running in the firewall zone, you are prompted to add
them: press Y and then Enter or N and then Enter, as appropriate, for each service. 

Note: If the service is already running, you are not prompted.

An overview of the firewall settings is displayed.

9. To save the changes permanently (that is, even after the firewall is restarted), press Y and then Enter;
to save the settings for the firewall until it is next stopped, N and then Enter. 

The utility is closed.

Note: If you need to remove any ports or services you have added to the firewall, use the firewall-
cmd utility that is part of the operating system.

Enabling SHIFT-JIS
By default, support for the character encoding for the Japanese language, Shift-JIS, is not available on
Ubuntu and on RedHat OS version 8 or later.

You need to generate the Shift JIS locale on your machine to be able to execute Shift-JIS applications on
these platforms. You can do this as follows:

1. On RedHat 8, ensure that the glibc-locale-source package is installed.
2. Execute the following command with superuser rights in order to generate a Shift-JIS locale using the

charset:

sudo localedef -f SHIFT_JIS -i ja_JP ja_JP.sjis

3. Set the COBUTF8 environment variable to the generated Shift-SJIS locale and LANG to a UTF8 locale:

export COBUTF8=ja_JP.sjis
export LANG=ja_JP.UTF-8

4. Run the cobutf8 utility:

cobutf8 <command>

See your product documentation for more details about cobutf8.

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Before performing a repair of the installation, Micro Focus recommends that you create backups of any
configuration files of the product that you might have changed.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOLDevelopmentHub9.0.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.
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To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.
After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid full license of Visual COBOL in order to continue using the product.

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus Customer Care.

Important: The SafeNet Sentinel licensing system has been deprecated and will be not available in
this product starting with the next major release - release 10.0.

The SafeNet Sentinel licenses will not be supported after release 9.0. You can only use AutoPass
licenses from release 10.0.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
However, it is not necessary to switch to AutoPass licenses unless you are adopting release 10.0.
Contact Micro Focus Customer Care for further information.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus Customer Care.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

Windows: To start the GUI Micro Focus License Administration

Windows 10 From your Windows desktop, click Start > Micro Focus License Manager > License
Administration.

Windows 11 Click the Start button in the Task Bar. Use the search field in the Start menu to find and
start License Administration.

Windows: To start the command-line Micro Focus License Administration tool

1. At a command prompt, navigate to:

C:\Program Files (x86)\Micro Focus\Licensing

2. Type cesadmintool.bat, and press Enter.

UNIX

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh
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Installing licenses
You need either a license file (with a .mflic extension for Sentinel RMS licenses or an .xml extension for
AutoPass licenses) or an authorization code which consists of a string of 16 alphanumeric characters
(Sentinel RMS licenses only). You need to install AutoPass licenses into the existing Micro Focus License
Administration tool, and not in the AutoPass License Server.

If you have a license file

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic or .xml).

• Drag and drop the license file from Windows Explorer to the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Visual COBOL.
2. Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
3. Click Browse next to the License file field.
4. Select the license file (which has an extension of either .mflic or .xml), and then click Open.
5. Click Finish to install the license.

Windows: To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Manual License Installation option by entering 4.
3. Enter the name and location of the license file.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code
Note: Authorization codes are only available with Sentinel RMS licensing.

Authorizing your product when you have an Internet connection
Note:

• This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.
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The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Windows: To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. On the Install tab, click Manual Authorization.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the Customer Care Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus Customer Care Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

Licensing Information | 85



Windows: To use the command-line Micro Focus License Administration tool

In order to authorize your product from the command-line Micro Focus License Administration tool you
must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by entering 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

entering 4.
7. Enter the name and location of the license file.

UNIX

In order to authorize your product you must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by entering 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

entering 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus Customer Care.
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Updates and Customer Care
Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and Customer Care
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• Product Updates on Software Licenses and Downloads, where you can download fixes and
documentation updates.

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter .

2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any
patch updates.

6. Click Download on the relevant row.
• The Examples and Utilities section of the Micro Focus Customer Care Web site, including demos and

additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.

• The Support Resources section of the Micro Focus Customer Care Web site, that includes
troubleshooting guides and information about how to raise an incident. Go to https://
supportline.microfocus.com/supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Portal.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product. See Micro Focus Channel on
YouTube.

• Micro Focus webinars: https://www.microfocus.com/en-us/resource-center/webinar.
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Information We Need
If your purpose in contacting Micro Focus is to raise a support issue with Customer Care, you should
collect some basic information before you contact us, and be ready to share it when you do.

Click here to see the Preparing to Raise a Support Case topic on the Product Documentation pages on
Micro Focus Customer Care, in the product help for Visual COBOL for Eclipse (Windows).

Click here to see the Preparing to Raise a Support Case topic on the Product Documentation pages on
Micro Focus Customer Care, in the product help for Visual COBOL for Eclipse (UNIX).

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus Customer
Care, your support representative might request that you provide additional debug files (as well as source
and data files) to help us determine the cause of the problem. If so, they will advise you how to create
them.
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Copyright and Disclaimer
© Copyright 2023 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.
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